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Preface

This section explains the objectives, intended audience, and organization of this publication and
describes the conventions that convey instructions and other information.

This section provides the following information:
< Revision History
» Document Objectives
- Audience
« Document Organization
» Related Documentation
- Document Convetions
- Obtaining Optical Networking Information
- Obtaining Documentation and Submitting a Service Request

Revision History

Date Notes

June 2011 Updated the section “Creating a Project” in the chapter “Creating and Analyzing
Networks”.

July 2011 Updated the section “Understanding Hybrid Configuration” in the chapter
“Introduction”.

March 2012 Updated the table “Optical Results Tab Columns” in the chapter “Viewing
Network Reports”.

August 2012 The full length book-PDF was generated.

Cisco Transport Planner DWDM Operations Guide, Release 9.3
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Document Objectives

The Cisco Transport Planner DWDM Operations Guide, Release 9.3 explains how to design networks
using the Cisco Transport Planner design tool for the Cisco ONS 15454 SONET and SDH systems. It
contains information about how to design an optical network. Use the Cisco Transport Planner DWDM
Operations Guide, Release 9.3 in conjunction with the appropriate publications listed in the Related
Documentation section.

Audience

This publication is intended for experienced network system engineers who are responsible for planning
and ordering equipment for Cisco optical networking systems.

Document Organization

This Cisco Transport Planner DWDM Operations Guide, Release 9.3 is organized into the following
chapters:

Chapter 1, “Introduction” provides a list of features, an overview of the network design process, a
description of the internal architecture, and the Cisco Transport Planner procedural flow.

Chapter 2, “Creating and Analyzing Networks” provides instructions for using the Cisco Transport
Planner tool to create a network design.

Chapter 3, “Viewing Network Reports” provides instructions for generating reports and bills of
materials.

Chapter 4, “Editing a Project” provides instructions for adjusting and optimizing design
components.

Chapter 5, “Modeled Network Examples” provides examples of typical optical networks that you
can model using Cisco Transport Planner.

Appendix A, “GUI Information and Shortcuts” provides Cisco Transport Planner graphical user
interface shortcuts.

Appendix B, “Card Types” provides a list of card types that can be used to build a network, and the
corresponding Cisco product identifier.

Appendix C, “System Messages” provides a list of system errors.

Appendix D, “Third-Party DWDM Wavelength Interface Model” provides reference information on
third-party DWDM interface calculation.

Appendix E, “Configuring CTP to Run on a Server” provides instructions to run CTP on a server.

Appendix F, “Pay As You Grow Bundles” provides information about the composition of each
PAYG bundle.
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Related Documentation

Use this Cisco Transport Planner DWDM Operations Guide, Release 9.3 in conjunction with the
following referenced Release 9.3 publications:

Cisco ONS 15454 DWDM Configuration Guide

Cisco ONS 15454 DWDM Troubleshooting Guide

Cisco ONS SONET TL1 Command Guide

Cisco ONS SDH TL1 Command Guide

Release Notes for Cisco Transport Planner

Release Notes for Cisco ONS 15454, ONS 15454 M2, and ONS 15454 M6 DWDM

Document Convetions

This publication uses the following conventions:

Convention Application

boldface Commands and keywords in body text.

italic Command input that is supplied by the user.

[ 1 Keywords or arguments that appear within square brackets are optional.
{x|x]|x} A choice of keywords (represented by x) appears in braces separated by

vertical bars. The user must select one.

Ctrl The control key. For example, where Ctrl + D is written, hold down the
Control key while pressing the D key.
screen font Examples of information displayed on the screen.

boldface screen font  Examples of information that the user must enter.

> Command parameters that must be replaced by module-specific codes.

Note  Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.
Caution ~ Means reader be careful. In this situation, the user might do something that could result in equipment

damage or loss of data.
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Warning

IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar
with standard practices for preventing accidents. To see translations of the warnings that appear in
this publication, refer to the translated safety warnings that accompanied this device.

Note: SAVE THESE INSTRUCTIONS

Note: This documentation is to be used in conjunction with the specific product installation guide
that shipped with the product. Please refer to the Installation Guide, Configuration Guide, or other
enclosed additional documentation for further details.

Obtaining Optical Networking Information

This section contains information that is specific to optical networking products. For information that
pertains to all of Cisco, refer to the Obtaining Documentation and Submitting a Service Request section.

Where to Find Safety and Warning Information

For safety and warning information, refer to the Cisco Optical Transport Products Safety and
Compliance Information document that accompanied the product. This publication describes the
international agency compliance and safety information for the Cisco ONS 15454 system. It also
includes translations of the safety warnings that appear in the ONS 15454 system documentation.

Cisco Optical Networking Product Documentation CD-ROM

Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is
available in a CD-ROM package that ships with your product. The Optical Networking Product
Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS Version 2.0.

Cisco Transport Planner DWDM Operations Guide, Release 9.3
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Note

Note

= CHAPTER 1

Introduction

Cisco MetroPlanner has been renamed to Cisco Transport Planner starting with release 8.5.

In this guide, M2 chassis refers to the Cisco ONS 15454 M2 chassis, M6 chassis refers to the
Cisco ONS 15454 M6 chassis, and M12 chassis refers to the Cisco ONS 15454 chassis.

Cisco Transport Planner (CTP) provides a way to model and test wavelength division multiplexing
(WDM) optical networks in a graphical environment. The primary purpose of Cisco Transport Planner
is to help sales engineers (SEs) design and validate networks of Cisco Optical Networking System
(ONS) 15454 Multiservice Transport Platforms (MSTP). Using the CTP, an SE can create multiple
instances of a network to modify different parameters in each instance for comparison. Cisco Transport
Planner generates a shelf view of all the sites deployed in the optical network and provides a complete
bill of materials (BoM) for the network and the differences between instances of a network.

This chapter describes how you use Cisco Transport Planner to design, analyze, and optimize new or
existing Cisco optical networks and contains the following sections:

« 1.1 Overview, page 1-1

« 1.2 Installing Cisco Transport Planner, page 1-15

« 1.3 Uninstalling Cisco Transport Planner, page 1-16

e 1.4 Launching Cisco Transport Planner, page 1-17

- 1.5 CTP Software Updates, page 1-20

- 1.6 Setting Cisco Transport Planner Options, page 1-20

» 1.8 Understanding the Pay As You Grow Feature, page 1-41

1.1 Qverview

This section describes the Cisco Transport Planner, Release 9.3 features, network design process,
process flow, traffic planning, traffic services, and parameter states.

[ oL-24717-01
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1.1.1 Cisco Transport Planner, Release 9.3 Features

Cisco Transport Planner software provides a simple tool set for designing optical networks with

Cisco ONS 15454 MSTP products. You can enter all of the network parameters or minimal information,
such as site distance, and Cisco Transport Planner will model the network you need to build and generate
a detailed BOM with ordering information. Designing optical networks requires the verification of
multiple constraints such as optical budget limitations and platform architectural restrictions. Single
Cisco Transport Planner project can contain multiple copies of a network. This duplication allows you
to change parameters in one network copy, then analyze and compare it with another network copy to
determine the differences. The new features of Cisco Transport Planner, Release 9.3 are listed in

Table 1-1.
Table 1-1 New Features in Cisco Transport Planner, Release 9.3
Features Description
15216-FLD-4 (FLD-4) FlexLayer |Supports bidirectional four-channel FlexLayer OADM units in
units MSTP 15454 ONS nodes that has the functionality as one of

these:
« Add/Drop
e Hub
- R-OADM
- OXC
-« OIC

The FLD-4 units are supported on the site of type 40-SMR1-C,
40-SMR2-C, 80-WXC-C, and 80-WXC-C MUX/DMX. The
FLD-4 units are also supported on the site of type 40-WXC-C on
the side configured as omnidirectional.

ONS-XC-8G-MM and
ONS-XC-10G-Epxx.x! XFPs

Supports ONS-XC-8G-MM and ONS-XC-10G-Epxx.x* XFPs.

OPT-EDFA-17 and OPT-EDFA-24
Amplifiers

Supports OPT-EDFA-17 and OPT-EDFA-24 amplifiers, which
are C-band amplifiers with gain range of 5 dB to 17 dB and 12 dB
to 24 dB with an output power of 20 dBm.

The OPT-EDFA-17 and OPT-EDFA-24 amplifiers can be forced
as preamplifier. The OPT-EDFA-17 and OPT-EDFA-24
amplifiers can be used in any MSTP or hybrid node. The
OPT-EDFA-17 and OPT-EDFA-24 amplifiers can be used as:

» Booster amplifier in add/drop nodes
» Post-amplifier in Raman amplified span

» Stand-alone line amplifier (OPT-EDFA-24) in case of
medium loss spans which does not require dispersion
compensation units (DCUs).

RAMAN-CTP and RAMAN-COP
amplifiers

Allows to place 15454-M-RAMAN-CTP and
15454-M-RAMAN-COP amplifiers.

Default site and fiber properties

Allows to specify default platform values for site and fiber
properties.

Cisco Transport Planner DWDM Operations Guide, Release 9.3
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Features Description
Networks with 150 sites Supports design of optical networks of up to a maximum of 150
sites.
Sherpa design import Supports the import of Sherpa designs created using the
Cisco Carrier Packet Transport (CPT) system into CTP networks.
Side label editing Allows to rename the sides with any alphabet between
A through H.
Wavelength numbering in the CTP | Supports the display of the wavelength serial number in the
reports wavelength routing, optical results and traffic matrix reports as

per the wavelength position in the odd or even grid in the C-Band.

1. xx.x=30.3t061.4

1.1.2 Network Design Process

To generate a network design, the SE enters the following parameters:
« The topology of the network—ring, linear, or meshed
» The type of equipment used at each site
» The distance separating the sites
« The type of fiber connecting the sites

« Service demands, including the service type, the protection type, and the number of channels
between nodes

« The number of network sites

When the network parameters are entered, Cisco Transport Planner finds the best routing, defines the
required add/drop filters, places optical amplifiers with dispersion compensation units (DCUs) or
tunable dispersion compensation units (TDCU) to fit the user traffic demands at a minimum cost. The
TDCU operates only over the C-band. Optimization is performed to meet the boundary conditions. The
optimization includes attenuation and amplification.

Finally, Cisco Transport Planner generates a BOM, which includes the product codes, the quantities, and
pricing information. In addition, it creates other reports, such as a shelf-level view of the configuration,
which can be printed. This information helps the SE understand how the shelf is built and helps to avoid
confusion and errors during the actual deployment. Within the BOM is the total network cost, which
allows a quick comparison of various design options. The total network cost is the cost of the equipment
for all of the sites in the designed network.

1.1.2.1 Network Design Constraints

Cisco Transport Planner searches for the best solution to a designed network using an optimization
algorithm.

A network design must meet the optical budget and receiver overload criteria to operate efficiently. An
analysis of the optical budget and receiver overload evaluates the strength of the signal traversing the
ring. If a design solution satisfies the constraints, it is a valid design. The Cisco Transport Planner
optimization algorithms generate multiple solutions and verifies the constraints against those solutions.
If the constraints are satisfied, the solution with the lowest cost-to-utilization ratio is selected as the
optimal solution.

[ oL-24717-01
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If the network design solution fails to satisfy all the constraints, Cisco Transport Planner makes
adjustments to parameters such as signal attenuation and amplification. Amplification is achieved using
an erbium-doped fiber amplifier (EDFA). Attenuation is achieved using the variable optical

attenuator (VOA) modules integrated into the platform. Cisco Transport Planner corrects the optical
budget using an algorithm that includes automatic placement of EDFAs and VVOA regulation.

For each internodal demand, Cisco Transport Planner performs an optical budget and receiver overload
analysis and displays the results in various reports in the Graphical User Interface (GUI). If the network
design algorithms are not able to provide a solution, then you can modify the input data (for example,
by relaxing some user constraints) and run the analysis again.

1.1.2.2 Platform Support

Cisco Transport Planner Software R9.3 supports the Cisco ONS 15454 DWDM optical platform
Software Releases 8.5, 9.0, 9.1, 9.2,9.2.1 and 9.3.

1.1.2.3 Topology Support

The Cisco Transport Planner supports the following network topologies:
» Linear (single-span or multispan)
» Ring (open or closed)
» Meshed

For more information on network topologies, see the “5.1 Supported Cisco Transport Planner
Topologies” section on page 5-1.

The Cisco Transport Planner enables you to design flexible networks with up to 150 site locations. A
flexible network uses ROADM nodes to allow traffic modification or reconfiguration, or both as traffic
requirements change.

In Cisco Transport Planner Software R9.3, the maximum number of locations where the optical service
channel (OSC) is terminated is 40. The maximum number of add/drop locations supported is 40.

Cisco Transport Planner DWDM Operations Guide, Release 9.3
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1.1.2.4 Protection Scheme Support

Cisco Transport Planner designs support the following protection schemes:

» Y-cable protected—In Y-cable protection, one transponder card is designated as active and the other
as standby. The standby transponder card has the client-side laser turned off to avoid corrupting the
signal transmitted back to the client. The active transponder monitors the signal from the trunk side
and in the event of loss or signal failure, the system switches to the standby path. Figure 1-1 shows
an example of a Y-cable protected link.

Figure 1-1 Y-cable protection

Tx}—»{Rx Tx}—»{Rx Side A

w TXP/MXP W Mux/Demux

Rx
Client Y cable
Tx

:

Tx}—){Rx Tx}—»{Rx Side B

P TXP/MXP P

R - Ry - Mux/Demux

W - Working (active)
P - Protect (standby)

246590

« Client-based 1+1—Two client signals are transmitted to separated line cards or transponder cards
instead of using a Y-cable to split one client signal into two line cards or transponder cards. In client
1+1 protection, the failure and switchover is controlled by the client system. Figure 1-2 shows an
example of a 1+1 protected link.

Figure 1-2 1+1 Protection
. —>Rx| X R Sidea
Client W TXP/MXP W
Mux/Demux
4—’? Rx }4—{ Tx
Cli _P)‘ﬂ TXP/MXP L }_P){ = Side B
lent Mux/Demux
<—’? Rx }(—{ Tx 9
g

W - Working (active)
P - Protect (standby)
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Fiber-switched protection—The single client signal is injected into the client receive (Rx) port. It is
then split into two separate signals on the two trunk transmit (Tx) ports. The two signals are
transmitted over diverse paths. The far-end card chooses one of the two trunk Rx port signals and
injects it into the Tx client port. Figure 1-3 shows an example of a fiber-switched protected link.

Figure 1-3 Fiber-switched Protection

Multitrunk card

X—RX] Sigea
Mux/Demux
Rx }(—{ Tx

Client TXP/MXP

Rx

=R Side s
Mux/Demux
Rx }(—{ Tx

246585

W - Working (active)
P - Protect (standby)

PSM-OCH—Channel protection configuration provides protection at trunk level (like
Fiber-Switched protection) for TXP/MXP that do not have dedicated Fiber-Switched cards. PSM
splits the traffic originated by transponder trunk on working and protected TX ports. Working Tx
(W-Tx) and protected TX (P-Tx) are connected to the add ports of Add-Drop stages adding the
channel in two different directions. On the receiving direction PSM W-RX and P-RX are connected
to the drop ports of Add-Drop stages receiving the channel from the two different directions. PSM
switch selects a path among W-Rx and P-Rx ports so that only one direction at a time is connected
to COM-RX ports and therefore to the TXP/MXP. Figure 1-4 shows an example of a PSM-OCH
protected link.

Figure 1-4 PSM-OCH Protection

X RX| Side A
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W - Working (active)
P - Protect (standby)

Unprotected—Protection is not used.

External card switch—Protection not used.
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1.1.2.5 Service Support

Cisco Transport Planner can support any subset of the following services:

Alien (third-party DWDM interface)
Cisco ONS 15530 2.5 Gbps Aggregated
ONS 15530 10 Gbps Aggregated

ONS 15530 Multirate (MR) Transport
ONS 15530 Data Multiplexer (MXP)

2R Any Rate

Gigabit Ethernet

10GE—10 Gigabit Ethernet (LAN and WAN)
D1 Video

DVB-ASI—Digital Video Broadcast-Asynchronous Serial Interface
DV-6000

DPSK—Different Phase Shift Keying
ESCON—Enterprise System Connection
Fast Ethernet

Fiber Channel 1G

Fiber Channel 2G

Fiber Channel 4G

Fiber Channel 8G

Fiber Channel 10G

FICON—Fiber Connection 1G

FICON Express 2G

FICON 4G

FICON 8G

FICON 10G

E3 over FE

T3 over FE

DS3 over FE

High Definition Television (HDTV)
ISC-3 Peer (1G)

ISC-3 Peer (2G)

ISC-3 Peer (2R)

ISC-Compat (ISC-3 Compatibility mode)
OC-3

0OC-12

0OC-48

overview W
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0C-192

OC-768

OTuU2

SDI—Serial Data Input

STM-1

STM-4

STM-16

STM-64

STM-256

10GE WAN-Phy

10GE LANtoWAN

OTuU2

OTU2e

OTU3

Sysplex CLO—control link oscillator
Sysplex ETR—external throughput rate

Note

The Sysplex CLO and Sysplex ETR services are supported only on the following topologies:

Single span—Two terminal sites with 32MUX-0O and 32DMX-O cards, 40MUX-0 and 40DMX-O
cards, 40WSS and 40DMX, or 32WSS and 32DMX or 32DMX-O cards installed and no
intermediate sites in between.

Point-to-Point—Two terminal sites with 32MUX-0 and 32DMX-0 cards. 40MUX-0 and
40DMX-0 cards, 40WSS and 40DMX, or 32WSS and 32DMX or 32DMX-O cards installed. Line
amplifiers can be installed between the terminal sites, but intermediate (traffic terminating) sites
cannot be installed.

Two hubs—Two hub nodes in a ring with 32MUX-0, 32DMX-0, 32WSS, 40MUX-0, 40DMX,
40DMX-0, 40WSS, and 32DMX cards or 32DMX-O cards installed. Line amplifiers can be
installed between the hubs.

Refer to the Cisco ONS 15454 DWDM Reference Manual for more information about the supported
topologies for the ETR and CLO services.

1.1.3 Cisco Transport Planner Process Flow

The following stages are used to complete a network design. See Figure 1-5 for the process flow.

1.
2.

Create a project using the Project Creation wizard.

Create a network using the Create Network wizard. The Create Network wizards adds sites and
places the fiber spans between the sites. A span represents a pair of fibers.

Create a point-to-point, AggregatedEthernet, TDM Aggregated, protected ring (P-ring), and/or
ROADM service demand.

Analyze the network design.

@ Cisco Transport Planner DWDM Operations Guide, Release 9.3
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5. If you would like to force automatic tool choices, adjust the design and repeat the analysis until you
have reached the desired configuration.

6. Create an Install copy of the network and update the parameters with real data from the field.
7. Analyze the Install network.
8. Create an upgrade copy of the network, as needed, to add forecasted channels.

Figure 1-5 Cisco Transport Planner Process Flow
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1.1.4 Planning Traffic in Cisco Transport Planner

Traffic in Cisco Transport Planner is defined as an optical path for each pair of nodes requiring a service
demand. An optical path is the combined channels between the two nodes. The following list gives
definitions for some basic traffic items:

» Circuit—A single channel between a pair of source and destination nodes. In addition to the source
and destination nodes and all the attributes that are common to the service containing the circuit, a
circuit has the following attributes:

Present/forecast indication
Routing direction for unprotected service
ITU channel

Optical bypass indication

« Demand—A set of circuits with common characteristics, such as:

Service demand label

Number of existing circuits

Number of forecasted circuits

Client service type

Protection type

Optical bypass (number of channels and/or sites)
WDM interface type (TXT or ITU-LC)

WDM card type

Source client interface (SR, IR, or LR)
Destination client interface (SR, IR, or LR)

» Traffic demand—All traffic between the same set of nodes. Both L-band and C-band are supported.
The following traffic demands are supported: P-ring, Fixed (point-to-point), and Any-to-any
(ROADM).

Note

In P-ring traffic demands, all the demands are used to support traffic topologies similar to
bidirectional line switched rings (BLSRs) or multiplex section-shared protection rings
(MS-SPRings). Each P-ring demand is between a pair of added/dropped nodes where
BLSR-like (or MS-SPRing-like) traffic must exist. The number of circuits is the same for each
demand, and is user-specified (from 1 to 40).

In fixed (point-to-point) traffic demands, the set of nodes is restricted to two sites. The number
of circuits is user-specified (from 1 to 40).

In any-to-any (ROADM) traffic demands, a minimum of two nodes and a maximum of 40
ROADM nodes are supported. The any-to-any traffic demand allows each node to establish one
or more circuits with the other nodes, either as a hub or meshed configuration. In a meshed
configuration, each node defined in the set is connected to each of the nodes. This is the most
common traffic type. In a hub configuration, the user-defined hub node is connected to each of
the other nodes. ROADM circuits have the same protection types and services. The number of
circuits is not user-specified and can vary from 0 to 40.

In any-to-any (ROADM) traffic demand, the default routing strategy is Unprotected minimum
hop count.
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A ROADM demand can have multiple client service types and support multiple DWDM card
interfaces for each client service type. A ROADM demand supports the following routing strategies:

Protected (Default)—Each node pair in the traffic demand is connected using two connections.

Unprotected optimum optical path—Each node pair is connected using one connection. The
unprotected optimum optical path minimizes the number of required optical amplifiers, but also
restricts the number of channels that can be deployed among the nodes of the traffic demand
(maximum of 40 channels between each node pair) in the installed network.

Unprotected minimum hop count—Each node pair in the traffic demand is connected by one
connection. The unprotected minimum hop count maximizes the number of channels (for
unprotected traffic types only) that can be deployed among the nodes of the traffic demand, but
requires a higher number of optical amplifiers on the unprotected optimum optical path
(maximum of 40 channels between each node pair) in the installed network.

Unprotected subnet—Each node pair in the traffic demand is connected using one connection.
You can manually force connections on only one branch of the ring. For unprotected subnets,
you must manually select one starting node of the branch and the direction the ring must be
traversed to define the subnet, starting from the initial site. The branch direction is specified by
defining the outgoing side first, referred to as the starting node. This routing strategy option
allows you to exclude some critical paths and (with ROADM traffic demands containing two
sites) to force each ROADM connection clockwise or counterclockwise.

1.1.5 Cisco Transport Planner Traffic in the Project Explorer Pane

Cisco Transport Planner represents all of the user-defined traffic services as a tree view within the
Project Explorer pane. The Project Explorer pane shows all of the open project information, including
the networks, the network dependencies, sites, fibers, services, and so on. (Figure 1-6).
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Figure 1-6 Project Explorer View

After you analyze a network design, the colors of tree view change according to the error/warning
condition of the network design. The icons display as red if there are errors in the network design; orange
if there are warnings but no errors; and green of there are no warnings or errors. The icon shows the color
of the most severe condition. For more information about analyzing the network, see the “2.9 Analyzing
the Network” section on page 2-48.

Right-clicking on certain items in the Project Explorer tree allows you to edit the parameters.

1.1.5.1 Point-to-Point Traffic Demands

Point-to-point traffic demands appear in the Service Demands > PointToPoint folder in the Project
Explorer pane. Each point-to-point traffic demand is categorized by its source and destination site
names. All of the point-to-point services between the two sites appear under the designated demand
name (Figure 1-7).

Figure 1-7 Point-to-Point Traffic Demand in the Project Explorer pane
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A point-to-point traffic demand includes the following information:
» Client service type
- Site# — Site# (source and destination site labels for this demand)

1.1.5.2 P-Ring Traffic Demands

Each protected ring (P-ring) traffic demand appears in the Project Explorer pane under the
Service Demands > P-Rings folder. Figure 1-8 shows an example of a P-ring traffic demand in the
Project Explorer pane.

Figure 1-8 P-Ring Traffic Demand in the Project Explorer pane

All the P-ring channels between each site pair are listed under each P-ring traffic demand. Each demand
is labeled with the following information:

e P-ring number
» Client service type
- Site# — Site# (source and destination site labels for this demand)

1.1.5.3 ROADM Traffic Demands

Each ROADM traffic demand appears in the Project Explorer pane under the Service Demands >
ROADMs folder. The ROADM folder contains each defined ROADM demand. You can define more
demands for the same ROADM for the same set of nodes. Figure 1-9 shows an example of a ROADM
traffic demand.

Figure 1-9 ROADM Traffic Demand in the Project Explorer pane

In the Project Explorer pane, each ROADM includes the ROADM demand name and a list of DWDM
card types that support the client service types. Protection types appear in parentheses.
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1.1.5.4 Aggregated Ethernet Demand

Each aggregated ethernet traffic demand appears in the Project Explorer pane under the Service
Demands > Aggregated Ethernet folder. The Aggregated Ethernet folder contains each defined
aggregated ethernet demand. Aggregated Ethernet demands are supported on ring and linear traffic
subnets. Figure 1-10 shows an example of an aggregated ethernet traffic demand.

Figure 1-10 Aggregated Ethernet Demand in Project Explorer pane

1.1.5.5 TDM Aggregated Demand

Each TDM aggregated demand appears in the Project Explorer pane under the Service Demands >
Aggregated TDMs folder. Figure 1-11 shows an example of a TDM aggregated traffic demand in the
Project Explorer pane.

Figure 1-11 TDM Aggregated Demand in Project Explorer pane

TDM aggregated demands are supported only on a ring traffic subnet.
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1.1.6 Auto, Forced, and Locked Parameters

Parameters in CTP can be in one of three states:

» Auto— This parameter allows the highest degree of flexibility to CTP in designing a network. When
you select Auto, CTP chooses the parameter value during network analysis.

» Forced—When you set a specific parameter value, other than Auto, CTP designs the network using
these constraints. When a setting is forced, the item appears in blue italics in the Project Explorer
pane.

» Locked—The state of a parameter after network analysis. The next time the analyzer is run, Cisco
Transport Planner cannot change the value when it is in the Locked state. You can unlock an item
using the Unlock command. For more information, see the “2.10.5 Unlocking Parameters in the
Network Design” section on page 2-54 and “2.10.5.1 Forcing Manager” section on page 2-54.
Figure 1-12 shows an example of sites in a locked state.

Figure 1-12 Locked Sites in the Project Explorer View

Depending on the initial state, the network analyzer will:
« Move the parameter into the Locked state if the unit or parameter was set to Auto.

» Leave the parameter in the same state if the user forced a specific value for the unit or parameter.

1.2 Installing Cisco Transport Planner

Use the following procedure to install Cisco Transport Planner:

Stepl1  To download the installer, go to the Cisco software download site.
Step2  Navigate to the location where you want to save the CTP executable file to a local hard drive.
Step3  Click Save.
Step4  To start the installation of CTP:
- Windows—Navigate to the folder containing the CTP executable file and double-click it.

« Linux—Assuming the CTP.bin file is accessible from the current shell path, navigate to the directory
containing the CTP.bin file and enter:

% ./CTP.bin
The graphical CTP installation wizard is displayed.
Step5  Click Next. The license agreement is displayed.
Step6  To accept the license, select the | accept the terms of the License Agreement radio button.
Step7  Click Next.
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Step 8

Step 9
Step 10

Step 11
Step 12

Step 13

Specify the installation folder. On Windows XP, the default is C:\Program Files\Cisco\CTP-R9.3.

To choose a different folder, click the Choose... button and browse to the required folder. To restore the
default path, click the Restore Default Folder button.

Click Next.
Specify the shortcut folder by choosing any one of the following options:
e Inanew Program Group—Specify a new folder. The default option is CTP-R9.3.
« Inan existing Program Group—Select a folder from the list of existing folders.
« In the Start Menu
« On the Desktop
e In the Quick Launch Bar
» Other—Use this option to specify a commonly used folder.

« Don't create icons—Choose this option if you do not want to create a shortcut.

Note  Check the Create Icons for All Users check box if you want to create shortcuts for all the users
of a system.

Click Next. The pre-installation summary is displayed.

Review the pre-installation summary. If no changes are required, click Install; otherwise, click Previous
to make modifications.

A progress bar displays the installation status. Click Cancel at any time to stop the installation.

When the installation process is complete, a screen indicates whether the installation succeeded or
failed.

Click Done to exit the installation wizard.

1.3 Uninstalling Cisco Transport Planner

Step 1

Step 2
Step 3

Step 4

Use the following procedure to uninstall Cisco Transport Planner:

Click the Uninstall CTP icon available at the location selected in Step 10 of the “1.2 Installing Cisco
Transport Planner” section on page 1-15.

The graphical Uninstall CTP wizard is displayed.

Click Uninstall.

A progress bar displays the uninstallation status. Click Cancel at any time to stop the uninstallation.
When the uninstallation process is complete, a screen displays the files that could not be uninstalled.

Click Done to exit the uninstallation wizard.
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1.4 Launching Cisco Transport Planner

Step 1

Step 2

Step 3
Step 4

Before you start Cisco Transport Planner, you need to save the user profiles provided to you by Cisco
Systems to the profiles folder available at the installation location. Access to Cisco Transport Planner
features depends on the user profile you select when you start Cisco Transport Planner. The default
profile is Base Network Designer.

Use the following procedure to launch Cisco Transport Planner:

Launch Cisco Transport Planner using any of the following options:
« Click the CTP icon in the Start > All Programs > CTP menu.
» Double-click the CTP icon in the quick launch bar.
» Double-click the CTP icon on the desktop.
« Browse to the installation folder and double-click the ctp.jar file.

The Cisco Transport Planner login dialog box is displayed. Select the user profile from the Current
selected profile drop-down list.

Select the user profile from the drop-down list.
Click Continue to open Cisco Transport Planner.

The login profile type appears in the lower-right corner of the Cisco Transport Planner window.

1.4.1 Opening a Project

Step 1

Step 2

Use the following procedure to open an existing Cisco Transport Planner project. To create a new
project, see 2.1 Creating a Project, page 2-1.

Click the project name under Open in the Tasks Pane (Figure 1-13). The project opens. If you do not see
the project name listed, continue with Step 2.

Click Open under Project in the Tasks Pane or in the File menu.
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Step 3

Note

Figure 1-13 Opening a Project from the Tasks Pane

In the Open Project dialog box, navigate to the desired folder and choose the project. Click Open. The
Cisco Transport Planner project appears.

You cannot open an existing CTP project in multiple CTP instances. The saved project (.MPZ file) is
locked for the use of that CTP. If you try to open the project in another instance of CTP, an error message
is displayed. The .MPZ project file is unlocked and released only after you close the Network.

1.4.2 Loading and Unloading Networks

Each network in a project requires memory. To save memory, when Cisco Transport Planner opens a
project, all networks are in the Unloaded state. An unloaded network appears in the Project Explorer
pane with a “U” next to the network identifier (Figure 1-14). To load an unloaded network, double-click
on the network folder in the Project Explorer pane, or right-click the network and choose Load from the

shortcut menu.

Figure 1-14 Unloaded Network in the Project Explorer pane

Cisco Transport Planner DWDM Operations Guide, Release 9.3
m. oL-24717-01 |



| Chapterl Introduction

Launching Cisco Transport Planner 1l

A loaded network appears in the Project Explorer pane with an “L” next to the network identifier
(Figure 1-15). To unload a loaded network, right-click the network icon in the Project Explorer pane and
choose Unload from the shortcut menu.

Note  When you load a network containing an alien interface that is not present in the parts database (DB),
warning messages are displayed.

Figure 1-15 Loaded Network in the Project Explorer pane

1.4.3 Saving a Project

Use the following procedure to save a project:

Step1  Choose one of the following:

« To save an existing project with the same filename, choose File > Save. You have completed this
procedure.

« To save a new project, choose File > Save and go to Step 2.
- To save an existing project with a different filename, choose File > Save As and go to Step 2.

Step2  In the Save Project dialog box, navigate to the desired folder and enter the filename. Click Save.
Cisco Transport Planner saves projects as zipped files with the MPZ extension.

1.4.4 Closing a Project

Use the following procedure to close a Cisco Transport Planner project:

Stepl  From the File menu, choose Close.
Step2  In the Save Project dialog box, click Yes to save or No to close without saving changes.

Step3  If you clicked Yes and have not previously saved the project, the Save Project dialog box appears. Enter
the name of the project and click Save. The project closes.

Step4  To exit Cisco Transport Planner, choose Exit from the File menu.
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1.5 CTP Software Updates

Software updates for Cisco Transport Planner are routinely made available for installation. Installing the
updates can rectify software errors and enhance software functionality. New updates can be installed
from a local patch (.upz) file.

1.5.1 Check for Software Updates

You can check for software updates after CTP has started. Click Check updates in the Help menu. The
Update CTP dialog box is displayed. In this dialog box, you can select either of the following options:

» Patch file—The updates are installed from a local .upz file. Click Browse to select the .upz file from
your local folder. CTP checks all the updates available on the .upz file and displays only those that
are new for the currently installed CTP version.

« Update server—CTP checks for online updates available on the server. The default server location
isdisplayed in the corresponding edit box. You can type a different server location, if required. Click
Ok to check for available updates on the server. Ensure that you have an internet connection.

Once the available updates are displayed, select those that need to be installed. Click Apply to install
the updates or Cancel to continue using CTP without installing any updates. After the updates have been
installed, you need to restart CTP for the updates to take effect.

Note  Before restarting CTP, clear the CTP cache from your local system.

To view the patch information, click About in the Help menu. The About Cisco Transport Planner dialog
box is displayed. Select the Patch Info tab to display the information about the currently installed patch.

1.5.2 Discarding Software Updates

The CTP can be rolled back to the previous working state if there are performance issues after installing
the new updates. At the time of launching CTP, a prompt is displayed to press the “R” key to perform
the roll back. If the software roll back does not complete successfully, an error message is displayed.

1.6 Setting Cisco Transport Planner Options

Cisco Transport Planner provides numerous options for customizing the tool and the design.

Note  The following procedures for setting options using the Tools menu apply to new projects during project
creation. To change an existing (open) project, click the desired item in the Project Explorer pane
Subnets folder and edit the parameter in the Properties pane.
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1.6.1 Setting the Graphical Display

Use the following procedure to set the Cisco Transport Planner graphical display:

Stepl  From the Tools menu, choose Options.

Step2  Inthe Options Explorer dialog box, right-click the Graphic folder and choose Expand from the shortcut
menu.

Step3  Click Chart Panel and complete the following:

In the Colors area, to change the colors of Border Paint, Background Paint, Line Paint, Plot
Background Paint, and Plot Outline Paint, click the relevant fields in the Colors list, and click the
drop-down arrow to display a color swatch popup window. Then, click the desired color.

In the Strokes area, to change the strokes of Border Stroke, Outline Stroke, and Default Line Stroke,
click the relevant fields in the Strokes list, and click the drop-down arrow. Then click the desired
stroke.

In the Font area, click the Font drop-down box to display a font popup window. Then select the
desired Font, Size and Style.

In the Alfa area, enter numeric values for Background Alfa and Foreground Alfa.
In the Shapes area, click the Line Shape drop-down box. Then click the desired line shape.

In the Gridlines area, check the Range Gridlines and Domain Gridlines check boxes to view the
gridlines for the same.

Step4  To change the color scheme for Cisco Transport Planner, click Look & Feel and choose the desired
scheme from the drop-down list.

Step5  To change the appearance of the Project Explorer tree, click Project Explorer and complete the
following tasks as needed:

Overlapping—Check to reorder sites for a selected network.

Alarm Mode—Choose Single for an alarm icon to report only the condition of that item or choose
Cumulated for an alarm icon to summarize the most critical alarm of the item and its children.

Bottom Right Icon—(Display only) Displays Locking to indicate that the lock icon appears at the
bottom right of each locked item in the Project Explorer pane.

Top Right Icon—(Display only) Displays Alarm to indicate that the alarm icon appears at the top
right of each alarmed item in the Project Explorer pane. The alarm icon will be green, yellow,
orange, or red to indicate the alarm severity.

Step6  To change the NtView Name tab appearance, click Network View and complete the following tasks as
needed:

In the Site area, complete the following tasks:

— Site Color—To set the default site color when no forcing is done, click the drop-down arrow to
display a color swatch popup window. Click the desired color.

- Site Selection Color, and Highlight Color—To change the site colors, click in the Color,
Selection Color, and/or Highlight Color fields in the Site list. Click the drop-down arrow to
display a color swatch popup window. Click the desired color.

- Show Name—Check to display the site name on the NtView Name tab.
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— Pass Through, OSC, Add/Drop, Hub, Gain equalizer, R-OADM, Line Amplifier, OXC, OIC,
Background Amplified Color, Background Raman Amplified Span Color—To change the
colors, click in the relevant fields in the Site list. Click the drop-down arrow to display a color
swatch popup window. Click the desired color.

- Show Amplifiers—Check to display the amplifier icon for a site on the NtView Name tab.

- Show Raman Amplified Span—Check to display the Raman amplified span on the NtView
Name tab.

« Inthe Fiber area, complete the following tasks, as needed.

— True wave Reach Color, Dispersion Shifted Color, Metro Core Color, true wave, True Wave Plus
Color, True Wave Minus Color, True wave Classic Color, Free Light Color, LS Color, Tera Light
Color, E LEAF Color, TRUE WAVE RS Color, G 652 SMF Color, and Selection Color—To
change the fiber color, click in the relevant fields in the Fiber list and then click the drop-down
arrow.

- Show Name—Check to display the fiber name on the NtView Name tab.

- Show Length—Check to display the fiber length on the NtView Name tab.

— Show total SOL Loss—Check to display start of life (SOL) loss on the NtView Name tab.
— Show total EOL Loss—Check to display end of life (EOL) loss on the NtView Name tab.

— Show CD C-band—Check to display C-band chromatic dispersion (CD) on the NtView Name
tab.

— Show CD L-band—Check to display L-band chromatic dispersion (CD) on the NtView Name
tab.

The duct details displayed in the NtView Name tab is shown in Figure 1-16.

Figure 1-16 Duct Details Shown on the NtView Name Tab

« To change the color of the traffic demands on the NtView Name tab, in the Point To Point, P-Ring,
and Any To Any areas, click in the Color and Selection Color fields, and then click on the drop-down
arrow to display a color swatch popup window. Click the desired color.

Step7  To change the Network Mgmt Tree tab appearance, complete the following tasks as needed:

« Inthe Network area, click in the Color and Selection fields. Click the drop-down arrow to display a
color swatch popup window. Click the desired color.

« Inthe Link area, complete the following tasks:

— To change the link color, click the Color field in the Link list and then click the drop-down
arrow. Choose the desired line width from the drop-down list.

— To change the link appearance, click the Stroke field in the Link list and then click the
drop-down arrow. Choose the desired line appearance from the drop-down list.
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Step8  To change the layout appearance, click Layout View and complete the following tasks as needed:

« Inthe General area, click in the Background and Selection Color fields. Click the drop-down arrow
to display a color swatch popup window. Click the desired color.

« Inthe Any/Present View area, complete the following tasks:

— To change the color for Foreground, Locked & Unlocked View, Locked Elements Background,
and Locked Elements Foreground, click the relevant field and click the drop-down arrow to
display a color swatch popup window. Click the desired color.

« Inthe Alarmed View area, complete the following tasks:

— To change the color for Unalarmed Elements Background, Unalarmed Elements Foreground,
and Alarmed Elements, click the relevant field and click the drop-down arrow to display a color
swatch popup window. Click the desired color.

Step9  Click Ok.

1.6.2 Setting the Default Software Release

Use the following procedure to set the default software release for CTP. This release will be used as the
default software release when creating a project. See 2.1 Creating a Project, page 2-1.

Stepl  From the Tools menu, choose Options.
Step2  In the Options Explorer dialog box click General.

Step3  In the column on the right, click the Default CTP Software Release option.
A drop-down list appears.
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Step4  Click an option in the list to choose the desired software release. See Figure 1-17.

Figure 1-17 Default CTP Software Release Window

Step5  Click Ok.

1.6.3 Setting the Default Platform Values

Use the following procedure to establish the default traffic mapping, dense wavelength division
multiplexing (DWDM) design, and default layout settings for a particular platform and system release.
The default settings will appear during project creation. All the options that you specify can be changed
after project creation on a per-span basis.

Stepl  From the Tools menu, choose Options.

Step2  In the Options Explorer dialog box (Figure 1-17), right-click Platform and choose Expand from the
shortcut menu.

Step3  Click the desired System Release folder and complete the following tasks as needed:

Note Default changes apply only to the specified system release.
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For Software Releases 8.5, 9.0, 9.1, 9.2, 9.2.1, and 9.3 choose the required settings:

Shelf Management—The options available are Auto, Multi Shelf Integrated Switch, Multi Shelf
External Switch, and Individual Shelf. These options allow you to specify the type of management
to be used for the sites on the network.

Select Auto to set the default option of Multi Shelf Switch for all the nodes with more than one shelf.
Select Multi Shelf Integrated Switch to configure all the Multiservice Transport Platform (MSTP)
optical units (OADMs and amplifiers) in different shelves connected through a LAN. The LAN is
implemented with switches plugged into the MSTP shelves.

Select Multi Shelf External Switch to configure all the MSTP optical units (OADMs and
amplifiers) in different shelves connected through a LAN. The LAN is implemented with switches
external to the MSTP shelves. For this option, two external Ethernet switch units

(Cisco Catalyst 2950 and Cisco Catalyst 3650) are used to support the multishelf configuration.
Cisco Catalyst 2950 supports 12 subtending shelves and Cisco Catalyst 3650 supports

24 subtending shelves. CTP supports a maximum of 30 shelves, including the node controller shelf,
in a multishelf configuration.

Note  When the Multi Shelf External Switch is forced, the multishelf external switch is placed in
the layout irrespective of the node controller.

Note  The Cisco ONS 15454 M6 (M6) chassis, when used as a node controller with the Multi Shelf
External Switch, can support only two subtended shelves.

Select Individual Shelf to configure all the MSTP optical units (OADMs and amplifiers) in the
same shelf.

Note  Shelf management is disabled for HYBRID 15454 ONS configuration in Release 9.1 and
later.

Note M6 chassis, when used as node controller, can support three subtended shelves, the
subtended M6 chassis can subtend two more shelves.

Node Protection—The options available are Same Shelf, Separated Shelves, and Node Split.
Select Same Shelf to configure the optical units (amplifiers and OADM) on side A (CW direction)
and side B (CCW direction) in the same shelf.

Note  Node protection is disabled for HYBRID 15454 ONS configuration in Release 9.1 and later.

Select Separated Shelves to configure the optical units (amplifiers and OADM) on side A (CW
direction) in one shelf and those on side B (CCW direction) in a second shelf.

C-band Rules—Select the options from the drop-down list. The options appear in the following
format: C 64 Chs 50 GHz (+2 dBm/Ch). The channels available are 80, 72, 64, 40, 32, 20, 16, and
8; the reference per channel power options available are -1 dBm, -2 dBm, 1 dBm, 2 dBm, 4 dBm, 5
dBm, 7 dBm and 8 dBm; and the spacing options available are 100 GHz and 50 GHz. You can use
even wavelengths for 80, 72, and 64 channel design.

For HYBRID 15454 ONS configuration, the available options are 8, 16, 20, 32, and 40 channels.
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» L-band Rules— Select the options from the drop-down list. The options appear in the following format:
32 Ch. 100 Ghz +5 dBm. The options available are: None, Expand, and channels available are 32; the
reference per channel power options available are 2 dBm and 5 dBm; and the only spacing options
available is 100 GHz.

Select Expand to indicate that the L-band rules are upgradable.

Note  L-band is not applicable to HYBRID 15454 ONS configuration in Release 9.1 and later.

« Installation w/o CTP—Check this check box to install the network with default parameters. If you
choose this option, CTP designs the network according to a set of predefined conditions, so that the
selected node can be installed without the Cisco Transport Planner configuration files (thresholds
and setpoints).

« Dithering Lower Limit—Enter a value that satisfies the following conditions:
— Not lower than zero
— Not higher than 32
— Not higher than the dithering upper-limit value

The dithering value is the site identifier that CTP uses to adjust power on 80-WXC cards. Dithering
value is provided only for sites with 40-WXC cards, that is, for sites with multidegree site structure
and with the functionality “OXC” or “Auto”. This parameter is not displayed for non-OXC sites.

- Dithering Upper Limit—Enter a value that is not lower than zero and not higher than 32.

« Insulators—Check this check box to protect the Express Add/Drop (EAD) colorless ports of the
80-WXC-C cards configured as demux units.

Note  The Cisco ONS 15216-FLD-2-1SO optical insulator is not supported in CTP Release 9.3.

Note  Optical insulator connections are displayed only in the Patchcord Installation tab in the
Internal Connections report.

» Structure—Choose the site structure from this drop-down list. If the network topology does not
support the selected site structure, then the selection made in this drop-down list is ignored.

- MSM External Switch—Choose the multi shelf external switch type, from the drop-down list.

» Use Payg—Check this check box to enable the Pay As You Grow feature. For more information
about the Pay As You Grow feature, see the “1.8 Understanding the Pay As You Grow Feature”
section on page 1-41.

« Service Level—Choose the service level, from the drop-down list.

« Service Level Num of Years—Choose the maintenance service level length (in years), from the
drop-down list.

« Redundant Power—This drop-down list enables you to choose whether the redundant power supply
is to be added.

« UTS AC Power Cables—Choose the type of cables to be used for the AC power supply, from the
drop-down list. Cables are listed based on the country type.
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Filler Card Type—Choose the type of card to be placed in the empty slots of a chassis, from the
drop-down list. The options available are:

— Blank—CTP places only blank cards.

— UTS Filler—CTP places blank cards in M12 chassis and Universal Transport System (UTS)
filler cards in the M2 and M6 chassis. The two type of UTS filler cards placed by CTP are
15454-M-T-FILLER (in TNC and TSC card slots) and 15454-M-FILLER (in other slots).

Node Controller—Choose a chassis to act as the node controller, from the drop-down list.
M6 Chassis in Use—Enter an integer value for the number of M6 chassis to be used.
M12 Chassis in Use—Enter an integer value for the number of M12 chassis to be used.

Redundant Controller Card—This drop-down list enables you to choose whether to use a redundant
controller card.

Side/Side cabling—Choose the loss value between the west and east side of the site, from the
drop-down list. It is useful in case of multi shelf node protection when the racks are not located close
to each other.

Anti ASE— The options available in the drop-down list are:

— Auto—CTP decides if the site should be configured as anti-amplified spontaneous emissions
(anti-ASE).

— Yes—The site is configured such that all the express channels on the site are optically dropped
and reinserted. In addition, all the patch cords between the West and East sections are removed.

— No—The site is not configured as anti-ASE.

Step4  Click the Layout folder and complete the following settings as required:

Osmine Compliant—Check this check box to instruct CTP to ensure that all the sites placing
transponder and line cards are compliant with OSMINE.

Hybrid Node—Check this check box to instruct CTP to ensure that cross-connect, SDH, and SONET
cards are not placed within the optical transport section (OTS) shelf.

Max Num of Shelves—Specify the maximum number of shelves per rack. The maximum number of
shelves you can specify is 4.

Fan Tray—Select the type of fan tray to be placed within each node, from the drop-down list.

AIC—Choose Yes from the drop-down list to instruct CTP to put the AIC card in slot 9 of the first
shelf in each site.

Fiber Storage—Choose Yes from the drop-down list to instruct CTP to put the fiber storage within
the rack below the optical shelf.

Y-Cable—The the Y-cable options from the drop-down list. The options available are:
- Auto—Instructs CTP to set the default value for the Y-Cable option.

— 1RU FlexLayer Shelf Assembly—Instructs CTP to use the ONS 15216 Splitter/Combiner
FlexLayer modules to implement the required Y-cable protections.

- 2RU Y-Cable Panel—Instructs CTP to use the new ADC Splitter/Combiner modules to
implement the required Y-cable protections.

TXP/MXP/XP in OTS—The options in the drop-down list enable you to choose whether to place
client cards in OTS shelves.

Etsi Rack Width—Choose the ETSI rack width from the drop-down list. The 19 inches option adds
15454E-191EC-KIT for each ETSI shelf.
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» Rack Height in RU—Enter an integer value for the rack height. The default option is Auto, which
assigns 44 rack units (RU) for ANSI and 40 RUs for ETSI.

« Alien Shelf Height—Enter the height of the alien shelves in RU. If the alien shelf height is greater
than the rack height, alien shelves will not be added to the site, and an error message will be
displayed in the summary report.

« Number of Alien Shelves—Enter the number of alien shelves that are to be added to the site.

Number of alien shelves can vary based on the alien shelf height. Maximum number of alien shelves
that can be added is 600, if the alien shelf height is 1 Rack Unit (RU) and there are no other shelves
in the layout.

The maximum number of racks supported for a site is 15. If the addition of alien shelves require
more than 15 racks, an error message will be displayed in the summary report and the layout is not
built for the site.

« Alien Shelf Name—Enter the name of the alien shelves that are added to the site. This name will be
displayed in the Layout reports.

» Populate Shelves From Bottom—Check this check box to instruct CTP to place the shelves in the rack
starting from the bottom. This is useful in installing shelves in tall racks. For more information about
the order in which CTP fills the rack, see the “4.14.1 General Placement Rules” section on
page 4-63.

» Chassis Type—Choose the type of chassis, from the drop-down list. The options available are Auto,
M12 Chassis, M6 Chassis, and M2 Chassis. The default option is Auto, which selects combinations
of the chassis in an optimized manner.

» Power Supply—Choose the type of power supply, from the drop-down list.

» DCC Shelves Management—Check this check box to instruct CTP to reserve Slot 12 for equipping
15454-MR-L1 units to implement data communication channel (DCC) shelf management.

« M12 Shelves—Enter an integer value for the number of empty M12 shelves to be added to the node
layout. CTP supports a maximum of 29 extra M12 shelves. The default option is Auto, which does
not add any shelves.

« M6 Shelves—Enter an integer value for the number of empty M6 shelves to be added to the node
layout. CTP supports a maximum of 29 extra M6 shelves. The default option is Auto, which does
not add any shelves.

« M2 Shelves—Enter an integer value for the number of empty M2 shelves to be added to the node
layout. The default option is Auto, which does not add any shelves.

The above values are applied to all the sites in the newly created network. The values can be
modified for individual sites after the network creation.

Step5  Click the Restricted Equipment folder. To restrict a card, check the corresponding check box in the
Restricted column for that card.

To change the setting back to unrestricted, uncheck the check box. To apply restricted list changes to an
open project, complete the following:

a. Right-click the folder for the network that you want to update and choose Expand from the shortcut
menu.

b. Right-click the desired platform and release folder under RestrictedEqptListFolder in the Project
Explorer pane and choose Edit List from the shortcut menu. The Restricted Equipment list for
MSTP 454 DWDM [Release Number] dialog box appears.
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Click Update. The modified Restricted Equipment List is replaced with the global restricted
equipment List.

Click OK to close the dialog box.

Click the Fiber Options folder and specify the fiber parameters as required:

Span Label Tag—Enter the desired span label; the default label is Duct.

Span Length—Enter the span length. The displayed unit of measure is retrieved from the
Span Measurements Units field.

EOL Ageing loss [dB]—Enter the EOL aging loss value. The EOL loss-per-span value is added at
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

EOL Ageing Factor—Enter the number to use when factoring fiber aging. This factor is multiplied
by the SOL total span loss without connectors.

Note  Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a
value in both fields.

Connector loss [dB]—Enter the concentrated loss at the end of the span.

Length Based Loss—If checked, the fiber loss is determined by multiplying the Span Length by the
Loss Factor. If this check box is unchecked, you must enter the total loss of the span.

Tot SOL loss w/o conn [dB]—Enter the total start of life (SOL) link fiber loss value for each span,
excluding the connector concentrated loss. This value is applicable only if the Length Based Loss
check box is unchecked.

DCN Extension (With Software R8.0 and later releases)—Check this check box to enable the default
use of data connection network (DCN) extension on each span in the project. This setting implies
that the OSC channel is not used to connect the two nodes. This default can be overridden on the
network wizard pane.

Use one of the following formulas to calculate the fiber loss at SOL:

SOL = km * dB/km + (2 * connector loss)

SOL = user entered loss + (2 * connector loss)

Use one of the following formulas to calculate the fiber loss at EOL:

EOL = km * dB/km * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss, or
EOL = user entered loss * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss

Select the Fiber Type of each span of the network. You can specify a fiber type even if the fiber type
is not supported for the design.

PMD at Fiber—Enter the polarization mode dispersion (PMD) value. PMD is always entered in
ps/nm/km.

Loss—Enter the value of the SOL fiber loss per kilometer used to calculate the loss of each span in
the network. The fiber loss factor is always entered in dB/km.
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Step7  Click the Traffic Mapping folder and complete the following tasks as needed.
« In the Fixed traffic area, choose the unprotected routing strategy from the drop-down list:

- Auto— CTP automatically selects the minimum number of channels that can be deployed
among the nodes of the traffic group.

— Unprotected optimum optical path—Each node pair is connected using one connection. The
unprotected optimum optical path minimizes the number of required optical amplifiers.

— Unprotected minimum hop count—Each node pair in the traffic group is connected by one
connection. The unprotected minimum hop count minimizes the number of channels (for
unprotected traffic types only) that can be deployed among the nodes of the traffic group.

« Inthe General area, choose the algorithm and wavelength options.

- Force Mesh Algorithm—~For CTP Software Release 8.5, check this check box to force the mesh
algorithm.

- Allow Different Wavelengths—Check this check box to allow different wavelengths to be used
for regeneration.

— Coloring Priority Option—Check to assign the wavelength from the left side of the available
band, that is, from 1530 nm. If this option is unchecked, the wavelength is assigned from the
right side of the available band, that is, from 1565 nm.

- Flat Grid Filling Option—Check to assign the wavelength in a flat grid, allocating each free
wavelength without any guard band. If this option is unchecked, the wavelength is assigned
according to the actual assignment rules.

Note  Guard band is an unused part of the wavelength spectrum, for the purpose of preventing
interference between the wavelength channels.

- Maximum Separation Option—Check to assign the wavelength related to the service types on
the 40G CP-DQPSK MXP and 40G CP-DQPSK ME MXP cards from one side of the
wavelength band, and from the opposite side for service types on other transponder cards.

Step8  Click the DWDM Design Rules folder and complete the following tasks as needed:

« OSNR Alarm For Regeneration—Allows you to define the optical signal-to-noise ratio (OSNR)
alarm severity. When this limit is reached, Cisco Transport Planner suggests a channel at an
appropriate site on the network. After the network is designed and analyzed, in the Tasks pane
(under Reports), click Optical Results to see if any site requires regeneration. The regeneration
column will suggest the site where Regeneration is required.

« Run Quick Analysis—Check to use a quick but less accurate algorithm to analyze the network in a
short time. After the analysis, Cisco Transport Planner displays the following warning message:
“Dcu design not optimized due to Run Quick Analysis option.”

« No-Tilt-Network-Design—Check to force Cisco Transport Planner to operate the amplifiers inside
the gain range where no tilt is generated and to determine the type and number of amplifiers in each
site of the network accordingly. This option sets all the intermediary points of the network so that
channels are always at the reference power level. The default value is Disabled.

Note  Long spans (with insertion loss greater than 25 dB) might not be supportable.
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No In-line Bulk Attenuator Design—Check to design the network without using any inline bulk
attenuators. If the network cannot be designed without using external in-line attenuators,

Cisco Transport Planner displays the following error message: “Unfeasible Network design. Site X
should require usage of in-line attenuator. Leave unchecked to allow inline bulk attenuators.”

No TXT/Line-Card Bulk Attenuator Design—Check to design the network without using any
external receive (Rx) bulk attenuators on transponder or line cards. If any of the clients require Rx
bulk attenuators, then the related channel is shown with the working condition (flagged red, orange,
or yellow). No Rx bulk attenuator will be shown in any of the reports (such as Optical Channel
Results, Internal Connections, or BoM). Leave unchecked to allow bulk attenuators.

Prevent Use of E-LEAF Dispersion Compensation Unit on E-LEAF Dispersion spans—Check to
prevent Cisco Transport Planner from using Extended -Large Effective area fiber (E-LEAF)
dispersion compensation units (DCUSs) on E-LEAF spans for the overall network. Leave unchecked
if you want the algorithm to automatically optimize the usage of the E-LEAF DCUs.

No DCU Design—Check to avoid automatic placement of DCU units.

Max Scalability Placement —The CTP allows you to scale up or expand the network made in your
network design. You can add new sites and demands depending on your requirements, thus, CTC
automatically creates the flexibility of the possible expansion of your network. It also checks to
force the CTP to choose an EDFA/DCU placement that is best suited for future expansion of the
designed network without any hardware changes.

TDCU—Cisco Transport Planner allows you to place the TDCU units (TDCU Coarse and TDCU
Fine) in the network. Select the options from the drop-down list:

- Auto—Cisco Transport Planner automatically places the fixed DCU units in the network.

— All Positions—Cisco Transport Planner places the TDCU units wherever the fixed DCU units
can be placed.

— Never Place—Cisco Transport Planner does not place the TDCU units in the network.

— Selected Positions—Cisco Transport Planner places the TDCU units in ROADM, WXC, and
Dynamic Gain Equalizer (DGE) nodes.

Turbo Simplex—Check to achieve faster results by optimizing a subset of the total channels based
on type and path rather than optimizing every channel. Unchecking this option can result in longer
analysis times for large networks, especially with any-to-any ROADM traffic.

Max Sc Value—Enables you to enter the maximum slope compensation value.

Enable Connector Loss—Check this check box to apply the default connector loss values to the
fiber. The applied value depends on the type of site where the fiber is connected:

Pass through Connector Loss—Enter the connector loss value for a pass-through site.
OXC Connector Loss—Enter the connector loss value for an OXC site.

ROADM Connector Loss—Enter the connector loss value for a ROADM site.

OSC Connector Loss—Enter the connector loss value for an OSC site.

Line Amplifier Connector Loss—Enter the connector loss value for a line amplifier site.
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Note  The Pass through Connector Loss, OXC Connector Loss, ROADM Connector Loss, OSC
Connector Loss, and Line Amplifier Connector Loss properties are enabled only if the Enable
Connector Loss check box is checked.

The values of these properties can also be specified in the Properties pane for the
Options>DWDM Design Rules>System Release option in the Project Explorer pane and are
applicable to the current network.

Step9  Click OK.

1.6.4 Setting the Default Project Values

Use the following procedure to set the default project settings and repair time. These defaults will appear
during project creation.

Stepl  From the Tools menu, choose Options.

Step2  Inthe Options Explorer dialog box (Figure 1-17 on page 1-24), click Project and complete the following
tasks to set the defaults that appear in the Project Creation wizard:

» Customer—Enter the default customer name (128-character maximum).
» Created by—Enter the default user name (128-character maximum).

« Measurement Units—Choose the default span length unit of measure from the drop-down list, either
Km or Miles.

» Price List—Choose the default price list.
» Restricted Analysis—Check to use Restricted Analysis in the project.

« ANSI/ETSI—Choose either ANSI (American National Standards Institute) or ETSI (European
Telecommunications Standards Institute) from the drop-down list.

Step3  Click General and complete the following tasks:

e« MTTR (hours)—Enter the mean time to repair (MTTR) for all sites in the network. This value will
apply to every site in the network. If you change the MTTR value after creating sites, the new value
will only apply to sites you create after the change.

» Restocking Time (days)—Enter the number of days required (including transportation time) to
restock the units into the maintenance center.

- Confidence Level (%)—Choose the confidence level for finding the spare units in the maintenance
center (50, 75, 95, or 99 percent).

» Default CTP Software Release—Choose a release to be set as the default CTP software release. This
release will be used as the default release when creating a project. See 2.1 Creating a Project,
page 2-1.

Step4  Click BoM and complete the following:

« Use Bundles—(Multishelf configuration only) Check to use the Multishelf Management Integrated
Kit bundle when generating the BoM instead of the single items. As a bundle, a common price is
quoted, which is lesser than when the items are listed individually.

» Use Global Discount—Check to allow you to edit the discount box (Global Discount).
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» Global Discount—Enter the global discount to be applied to the whole BoM.

« Include SW License(s)—This check box is checked by default. The software license for the release
is shipped with the Cisco ONS 15454 chassis.

» Include Paper Documentation—Check to ship paper documentation separately with the product and
listed in BoM.

e Include CD Documentation—Check to ship CD documentation separately with the product and
listed in BoM.

« Hide BoM price/discount—Check to hide the BoM discount and the individual unit price. Only the
final price is displayed.

« Service Level—Choose the service level from the drop-down list.

» Service Level Num of Years—Choose the maintenance service level length (in years) from the
drop-down list.

Click OK.

1.6.5 Defining Third-Party DWDM Interfaces

Note

Step 1

Step 2
Step 3

Step 4

Step 5
Step 6

Cisco Transport Planner allows you to define a third-party DWDM interface to be used in project
creation. After you define third-party DWDM interfaces, you can choose them when creating traffic
demands. For more information on defining third-party interfaces, see Appendix D, “Third-Party
DWDM Wavelength Interface Model.”

If you create a network design with a third-party interface and need to share the design with other users,
you must provide not only the saved network MPZ file but also the exported database file containing the
third-party interface definition. To view this project, the other user first must import the database with
the third-party interface values.

Use the following procedure to define a third-party DWDM interface:

Click Tools > DB Parts Mgmt. The DB Parts Manager dialog box appears.

Note  You cannot open the DB Parts Manager if a project is open or if you are using the Base Network
Designer profile.

Right-click Platform Parts and choose Expand from the shortcut menu.

Right-click Group and choose New Group from the shortcut menu. The new group appears under Group
and in each system release under parts DB.

In the Group Editor dialog box, complete the following information:

» Name of group—Enter the name of the new database.

« Note—(Optional) Enter a description of the group.

In the parts DB for the desired system release, click the group that you created.

In the Parts tab of the DB Parts Manager dialog box, right-click and choose Client and then Alien from
the shortcut menu. A new row appears on the Parts tab for the client hardware.
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Step7  Double-click the row to open the Alien dialog box (Figure 1-18).

Figure 1-18 Alien Card Dialog Box

Step8  Inthe General tab of the Alien dialog box, type the name of the card in the Name field and the enter the
Label name.

Step9  Click the Istance tab and complete the following:

« Ansi PID—Enter the product identifier of the ANSI system, as needed. If you select BoM visible
for this third-party interface with ANSI PID completed, the third-party interface is included in the
BoM with the related product identifier.

» Etsi PID—Enter the product identifier of the ETSI system, as needed. If you select BoM visible for
this third-party interface with ETSI PID completed, the third-party interface is included in the BoM
with the related product identifier.

« TAG—(Display only) For internal use.
- SYS. NAME ANSI—Not applicable for third-party interfaces.
» SYS. NAME ETSI—Not applicable for third-party interfaces.

» WL START—Choose the wavelength starting range that the third-party interface supports from the
drop-down list.

- WL END—Choose the wavelength ending range that the third-party interface supports from the
drop-down list.

Step 10  Click the Physical Ports tab and in the Label column, type a label for each port.
The CTC Ports and TL1 Ports tabs are not applicable for third-party interfaces.
Step11  Click Ok.
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Step 12 In the Parts tab of the DB Parts Manager dialog box, right-click and choose Software and then Alien
from the shortcut menu. A new row appears on the Parts tab for the client software.

Step 13 Double-click the row to open the AlienSoft dialog box.
Step 14 In the General tab, complete the following:
- Name—Enter the name in the Name field.
« Related Item—Choose the client card that you created in Step 7 to Step 11.
Step 15  Click any of the following depending on the client card that you choose and proceed to Step 16:
» Default - OCh tab (Figure 1-19)
- DPSK-OCh tab
» QPSK-OCh tab

Figure 1-19 AlienSoft Dialog Box, Default-OCH Tab

Step 16 Complete the following (see Tables 1-2 through 1-4 for supported value combinations):
« Inthe Rules area, choose the C-band or L-band design rule from the Design Rule drop-down list.
« In the Technology area, complete the following:
— Modulation Format—Choose NRZ (Non Return to Zero) or Duo Binary.

— Transmitter Type—Choose MZ (Mach Zehnder), DML (Direct Modulated Laser), or
EML (Electro-absorption Modulated Laser).
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— Receiver Threshold—Choose Optimal (minimum BER) or Average (average received power).
For DPSK—Choose the Receiver Threshold as Optimal.
For QPSK—Choose the Receiver Threshold as Average.

- Regeneration Type—Choose 3R or 2R regeneration mode.

- FEC Mode—Choose FEC (Forward Error Correction), no FEC, or E-FEC (Enhanced FEC).
For DPSK or QPSK, set the FEC Mode to E-FEC.

— Transmitter Stability—Choose the maximum wavelength error allowed (pm). The values are
12.5, 25, 50, or 100 pm.

« Bit Rate—Choose the desired bit rate from the drop-down list. For DPSK or QPSK, choose the Bit
Rate as 40 Gb/s.

« Inthe TX Power Range area, complete the following:
— TX Max Power—Enter the maximum power output level (dBm).
— TX Min Power—Enter the minimum power output level (dBm).

- Inthe Back to Back Receiver Sensitivity area, complete the following as needed to define the
working interface area for Back to Back. Back to Back is a configuration where the receiver is placed
in front of the transmitter and no other equipment exists between the two. Back to Back is used to
measure characteristics of the TX and RX pair. Figure 1-20 shows the interface operative area.

— Overload Power [ps/nm]—Enter the overload power level.
— OL_Power [dBm]—Enter the minimum power level in the OSNR-limited range.

— OL_OSNR [dB] on 0.5 nm RBW—Enter the minimum OSNR level in the OSNR-limited range
(measured in 0.5 increments).

— PL_Power [dBm]—Enter the minimum power level in the power-limited range.

— PL_OSNR [dB] on 0.5 nm RBW—Enter the minimum power level in the OSNR-limited range
(measured on 0.5 nm bandwidth).

« Inthe Chromatic Dispersion area, complete the following as needed:

— Customize CD Robustness—Check to enable the CD Robustness field, as needed. Chromatic
dispersion (CD) refers to the broadening of a light pulse after traveling a distance in the fiber.

— CD Robustness [ps/(nm*km)]—If Customize CD Robustness is checked, choose the maximum
positive dispersion, Dmax_pos [ps/(nm*km)], tolerable by the interface: 0 dB, 1 dB, 1.5 dB,
2 dB, or 3 dB.

« Customize Penalties—Check to enable the Gaussian cross-talk Penalties, Single-Interfering
Cross-Talk Penalties, and Scale Q factors fields as needed.

- If Customize Penalties is checked, enter the values to determine the Gaussian cross-talk Penalties in
the A_GXt and B_GXt fields, as needed. Gaussian cross talk refers to random power that interferes
with a signal. The A_GXt and B_GXt values are the coefficients for the exponential curves that
estimate P-penalty (PL), P-penalty (OL), OSNR-penalty (PL), and OSNR-penalty (OL) for
Gaussion cross-talk levels in the OL and PL regions of the interface model with dispersion margins
added (see Figure 1-20). The formula is Penalty (GXt) = A_GXt * exp(B_GXt *GXt).

- If Customize Penalties is checked, enter the values to determine the Single-Interfering Cross-Talk
Penalties in the A_SIXt and B_SIXt fields, as needed. Single-interfering cross talk refers to
interference caused by a single signal. The A_SIXt and B_SIXt values are the coefficients for the
exponential curves that estimate P-penalty (PL), P-penalty (OL), OSNR-penalty (PL), and
OSNR-penalty (OL) for single-interfering cross-talk in the OL and PL regions of the interface model
with dispersion margins added (see Figure 1-20). The formula is Penalty (IXt) = A_SIXt*
exp(B_SIXt* IXt).
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If Customize Penalties is checked, enter Scale Q values in the F-P(PL), F-P(OL), F-OSNR(PL), and
F-OSNR(OL) fields, as needed. The scale factors measure how efficient a card is in recovering the
signal distortion. The slope of the Q-factor curve versus OSNR or RX power determines how a BER
increase could be recovered with an increase of OSNR, power, or both (depending in which
OSNR/power working point the card is). In general, the scale factors are two values (one in OSNR
and one in power) for each working point OL and PL of the interface model (see Figure 1-20). The
the F-P(PL), F-P(OL), F-OSNR(PL), and F-OSNR(OL) values translate a Q-penalty (that is, a BER
increase) into power and OSNR penalties. The formulas follow:

— P-penalty(PL) = Q-penalty * F-P(PL)
— P-penalty(OL) = Q-penalty * F-P(OL)
— OSNR-penalty(PL) = Q-penalty * F-OSNR(PL)
— OSNR-penalty(OL) = Q-penalty * F-OSNR(OL)

F-P(PL) and F-OSNR(PL) are evaluated in the PL working region, while F-P(OL) and F-OSNR(OL)
are evaluated in the OL working region of the curve with the dispersion margins added.

Figure 1-20 Interface Operative Area
A
Overload
Power
@
=
o
o}
e}
g
E
— o .
ch % Working Area
=21 o
(O]
2
o
o
oL
PL Power - limited border
OSNR [dB] 5]
Click Ok.

Table 1-2 lists the supported combinations for 40-Gbps third party interfaces.
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Table 1-2 Supported Combination for 40-Gbps Third-Party Interface
> Chromatic Dispersion Penalties [dBm]
Modulation RX Stability | P-penalty OSNR- P-penalty OSNR-
Format TX Type Threshold |FEC [pm] (OL) penalty (OL) |(PL) penalty (PL)
Duo Binary |MZ Optimal E-FEC +12 0 1 0 1
Table 1-3 lists the supported combinations for 10-Gbps third party interfaces.
Table 1-3 Supported Combinations for 10-Gbps Third-Party Interface
X Chromatic Dispersion Penalties [dBm]
Modulation RX Stability |P-penalty OSNR- OSNR-
Format TX Type Threshold |FEC [pm] (OoL) penalty (OL) |P-penalty(PL) |penalty (PL)
NRZ Mz Optimal E-FEC +25 0 2 1 0
NRZ Mz Optimal FEC +25 0 1.5 1 0
NRZ MZ Average no FEC +25 2 0 2 0
NRZ EML Average no FEC +100 0 3 3 0
Table 1-4 lists the supported combinations for 2.5-Gbps third party interfaces.
Table 1-4 Supported Combinations for 2.5-Gbps Third-Party Interface
> Chromatic Dispersion Penalties [dBm]
Modulation RX Stability |P-penalty OSNR- P-penalty OSNR-
Format TX Type Threshold |FEC [pm] (OL) penalty (OL) |(PL) penalty (PL)
NRZ DML Average FEC +25 0 2 2 0
NRZ DML Average no FEC +25 0 2 2 0
NRZ DML Average no FEC +25 3 0 3 0
NRZ DML Average no FEC +25 3 3 3 3
NRZzZ EML Average no FEC +25 0 2 2 0
NRZ DML Average no FEC +100 0 3 3 0

1.6.6 Exporting User Options, Price Lists or Alien Definitions

Step 1
Step 2

Use the following procedure to export user options, price lists, maintenance contracts, and the parts
database files. The export command creates a ZIP file that includes all of the created files.

From the Tools menu, choose Export. The Export dialog box appears.

In the Export dialog box, enter a file path and name in the file name field. To export to an existing file,

click the ... button and navigate to the desired folder and file. Click Select to choose the file.
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Step3  To select the items to export, complete the following as needed:
» User Option—Check to export the user options set using the Tools > Options command.
- PartsDB—Check the desired platforms.

« PriceDB—Check All Price DB to export all price lists, or expand All Price DB and check the
individual price lists that you want to export.

Step4  Click Ok.

1.6.7 Importing User Options, Price Lists or Alien Definitions

Use the following procedure to import user options, price lists, maintenance contracts, and the parts
database files. You can import a ZIP file of multiple exported items or an individual TXT file.

Step1  From the Tools menu, choose Import. The Import dialog box appears.

Step2 In the Import dialog box, click the ... button and navigate to the desired folder and file. Click Select to
choose the file to import.

Step3  Click load.

Step4  If you selected a single TXT file, skip this step and go to Step 5. If you selected a ZIP file with multiple
exported options, complete the following as needed:

» User Option—Leave checked to import a file with the user options that were set with the Tools >
Options command.

» PartsDB—Leave checked to import the parts database for the desired platform.

» PriceDB—Leave All Price DB checked to import all price lists, or uncheck and check the desired
individual price lists.

Step5  Click OK.
Step6  In the confirmation dialog box, click OK.

1.6.8 Importing Osmine Configuration File

The Osmine configuration updates are provided in an Osmine configuration file. When a new Osmine
configuration file is available, use this procedure to import it. The networks analyzed after the import
operation will be OSMINE compliant as per the configurations provided in the Osmine configuration
file.

Stepl  From the Tools menu, choose Osmine File Import. The Select Osmine Config File dialog box is
displayed.

Step2  Browse for the Osmine configuration file.

Step3  Click Open. The new configuration is loaded into CTP.

Cisco Transport Planner DWDM Operations Guide, Release 9.3
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1.6.9 Resetting the Default Layout

Your graphical layout settings are saved when you exit Cisco Transport Planner. The next time that you
launch Cisco Transport Planner, the layout appears as it did upon exiting. The default graphical layout
includes items such as whether the panes are visible and/or docked.

To return to the Cisco Transport Planner default layout, choose Default Layout from the View menu. To
restore the user modified layout, choose My Default View from the View menu.

1.6.10 Adding User Profiles

Step 1
Step 2

Step 3
Step 4
Step 5

A user profile is a set of privileges used for running Cisco Transport Planner. Each profile offers different
capabilities. Cisco Transport Planner is packaged with the Network Designer profile, but you can add
other user profile types provided by Cisco. All the procedures in the Cisco Transport Planner DWDM
Operations Guide are written for users with Network Designer access.

Use the following procedure to add a user profile to Cisco Transport Planner:

Close all open instances of Cisco Transport Planner.

Identify the folder where Cisco Transport Planner is installed on your computer, see the “1.4 Launching
Cisco Transport Planner” section on page 1-17.

Create a profile folder; if profile folder already exists, go to Step 4.
Copy the profile JAR file provided by Cisco Systems into the profile folder.

Launch Cisco Transport Planner. For more information, see the “1.4 Launching Cisco Transport
Planner” section on page 1-17. The new profile will appear in the Current Selected Profile drop-down
list.

1.6.11 Understanding Sides Labeling

In Cisco Transport Planner Software R8.5 and later, the label for each supported site structure is different
from the labels that have been used in the previous releases. Table 1-5 summarizes the labeling format
in Cisco Transport Planner.

Table 1-5 Sides Labeling in Cisco Transport Planner
Default labeling in Cisco Transport
Sites Labeling in Previous Releases Planner Software R8.5 and later
Terminal/Terminal+ Only one side is created and Label A is used for the existing side.
labeled, T.
Line/Line+ Two sides are created and are Labels A and B are used for the existing
labeled, West and East. sides.
Multidegree with — Labels A, B, C, and D are used for the
PP-MESH-4 existing sides.
Multidegree with — Labels A, B, C, D, E, F, G, and H are used
PP-MESH-8 for the existing sides.
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Table 1-5 Sides Labeling in Cisco Transport Planner

Default labeling in Cisco Transport
Sites Labeling in Previous Releases Planner Software R8.5 and later

PSM Line — Labels Aw and Ap are used for the
existing sides, where w stands for
working and p stands for protection.

PSM Section — Labels Aw and Ap are used for the
existing sides, where w stands for
working and p stands for protection.

The default labels applied to the sides can be edited. For more information about editing side labels, see
the “4.4 Editing Side Labels” section on page 4-39.

1.7 Understanding Hybrid Configuration

Typically a node has ONS 15454 MSTP configuration with add/drop units like 40-MUX-C/40-DMX-C,
ROADM units and so on. However, the node configuration can also have ONS 15454 amplifiers along
with ONS 15216 FlexLayer add/drop units like FLB-2s, FLA-8s, and FLD-4s, and is known as Hybrid
15454 ONS configuration. A network design can have up to 80 channels in a typical MSTP
configuration; however, in a Hybrid configuration the number of channels is restricted to 40. In a Hybrid
configuration, the Data Connection Network (DCN) manages the traffic instead of Optical Service
Channel (OSC). Hybrid nodes are add/drop nodes with express traffic and are comparatively less
expensive than MSTP nodes.

1.8 Understanding the Pay As You Grow Feature

The Pay As You Grow (PAYG) feature enables you to implement a cost effective solution when the
wavelength requirements are comparatively less than the maximum capacity of the network. Instead of
purchasing a standard card that is configured to work on maximum supported wavelengths, you can
purchase a PAYG bundle that comprises of license restricted cards and a base license. The license
restricted cards support only a number of wavelengths for which the licenses are installed on the card.
The base license supports only 10 wavelengths. Therefore, a license restricted card having only the base
license will support only ten wavelengths even if its maximum capacity is to support 40 wavelengths.
The cost of the PAYG bundle is less than the cost of the standard card. For more information about the
PAYG bundles, see the Appendix F, “Pay As You Grow Bundles”.

When there is a need of more than ten wavelengths, additional licenses can be purchased to support the
increased demand. Each new license supports ten additional wavelengths. Therefore, the PAYG
functionality significantly reduces the initial setup cost and enables the purchase of additional
wavelength capacity on a need basis.

During the analysis of the network, the CTP algorithm decides on whether to use a standard card or a
PAY G bundle depending on the lower implementation cost.
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Cisco Transport Planner DWDM Operations Guide, Release 9.3 i



Chapter1 Introduction |

M Understanding the Pay As You Grow Feature

The cards and units that support a PAYG bundle are:
e 40-SMR1-C
- 40-SMR2-C
- 80-WXC-C
- 15216-MD-40-ODD

The PAYG licensing is applied to each side of every site. The license depends on the cards placed on that
side and the wavelengths that are added, dropped, or expressed. The PAYG licensing is not dependent
on site, type, or functionality.

The applied PAYG bundle is displayed in the Bill of Material of the site. To view it, right-click the site
in the Project Explorer pane and select the Bill of Material option from the shortcut menu.

The PAYG bundle to which a card is associated is displayed in the card property. To view it, select the
card in the Project Explorer pane; the PAYG bundle name is displayed for the Payg Bundle property in
the Properties pane.

1.8.1 Unlock Pay As You Grow Bundles

Note

When a license restricted card is associated with a PAY G bundle, the association is maintained for future
analysis. Therefore, if the network is analyzed with increased wavelength demands, CTP adds additional
licenses even though using a standard card is cost effective.

During a network upgrade, the association of the license restricted card with the PAYG bundle is not
modified unless the Unlock Pay As You Grow Bundle option is selected. Right-click the site either in
the Project Explorer pane or in the NtView Name tab, and select the Unlock Pay As You Grow Bundles
option from the shortcut menu. On selecting the Unlock Pay As You Grow Bundle option all the PAYG
bundle information from a previous analysis are deleted and are recalculated when the network is
analyzed again.

The Unlock Pay As You Grow Bundle option is enabled only in the Upgrade or Install mode.

1.8.2 Forcing PAYG Bundles On a Card

Note

The Developer and Optical Designer profile users can decide whether to associate a card with the PAYG
bundle or not. Select the card in the Project Explorer pane; the Force Payg drop-down list is displayed
in the Properties pane. The options available are:

« Auto—The PAYG bundle or the standard card is used based on cost effectiveness.

« Yes—The card is always associated with the PAYG bundle even if using the PAYG bundle is not the
most cost effective solution.

« No—The card is never associated with a PAYG bundle even if using the PAYG bundle is a more cost
effective solution.

The Force Payg drop-down list is enabled only in the Upgrade and Install modes, when the card is in the
locked state.
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A project consists of a single network or multiple networks that you analyze and compare. In a project,
you can have multiple copies of a single network with the same customer input data, but use different
options in each to investigate multiple solutions.

2.1 Creating a Project

Note

Use the following procedure to create a single network in a project. A new network is in the Design state.
For more information about the different network states, see the “2.10 Managing the Network Design”
section on page 2-50.

All options that the Project Creation Wizard sets can be changed as needed, except Measurement Units
and ANSI/ETSI.

[ oL-24717-01
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Step1  From the File menu, choose New. The Project Creation Wizard appears (Figure 2-1).

Figure 2-1 Project Creation Wizard

Step2  In the Project Parameters area complete the following:
- Created By—Enter a user name. You can enter a maximum of 128 character.

» Customer Name—Enter the name of the customer requiring this network design. You can enter a
maximum of 128 character.

« Network Platform Layout—Choose ANSI (the North American standard) or ETSI (the international
standard) from the drop-down list to indicate the platform type. ANSI networks will not allow you
to define SDH (ETSI) service demands. ETSI networks will not allow you to define SONET (ANSI)
service demands.

» Span Measurement Units—Choose Km (kilometers) or Miles from the drop-down list to set the unit
of measure used for span length.

» Price List—Choose a price list from the drop-down list.

Step3  Click Next.
The Choose Platform area appears.

Step4  In the Choose Platform area, check the desired platform and click Next.
The Choose Release area appears.

Step5  In the Choose Release area, check the desired software release for the network design and click Next.
The Subnet Options area appears.
To set a default software release see “1.6.2 Setting the Default Software Release” section on page 1-23.
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Step 7

Step 8

Step 9

Step 10

Step 11

Step 12
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In the Subnet Options area, complete the following:

- Traffic Mapping Algorithm Release 9.3—Check to select the ONS 15454 Software R9.3 version of
the interface and the wavelength routing optimization algorithm to be used in the network design.
Software R9.3 is backward compatible: it allows you to manage Software Releases 8.5, 9.0, 9.1, and
9.2,9.2.1 and load 7.0 and 8.0.

» Design Rules Release 9.3—Check to select DWDM Design Rules Release 9.3.

« Layout Release 9.3—Check to define the ONS 15454 Software R9.3 version of the algorithm used
to generate the layout of each site within the subnetwork.
Software R9.3 is backward compatible: it allows you to manage Software Releases 8.5, 9.0, 9.1, and
9.2,9.2.1 and load 7.0 and 8.0.

« Bundle Licensing Release 9.3—Check this check box to select the PAYG bundle licensing for
Release 9.3. For more information about the Pay As You Grow (PAYG) feature, see the
“1.8 Understanding the Pay As You Grow Feature” section on page 1-41.

Click Next.
Complete one of the following:

« Torun the Network Creation wizard, check the Run the Network Wizard Now check box and click
Finish. Continue with Step 9.

- To create an empty project to add sites and fibers manually, un-check the Run the Network Wizard
Now check box and click Finish. Project Creation wizard creates the project and an empty network
and subnetwork where you can manually add sites and fibers. Skip the remaining steps in this
procedure. To add sites manually, see the “2.2 Adding Sites” section on page 2-10.

In the Topology area of the Network Creation wizard, choose one of the following options from the
Network-Topology drop-down list:

« Ring—Supports both MSTP 15454 ONS and HYBRID 15454 ONS configurations.

Note In HYBRID 15454 ONS configuration, at least one node must be hub for the ring topology.

e Linear—Supports both MSTP 15454 ONS and HYBRID 15454 ONS configurations.
e PSM Line—Supports only MSTP 15454 ONS configuration.
» PSM Section—Supports only MSTP 15454 ONS configuration.

To instruct Cisco Transport Planner to automatically create a traffic subnet associated with the created
network, check the Create Traffic Subnet check box. Cisco Transport Planner creates (in addition to the
Traffic_ALL) an additional traffic subnet (Traffic_Ring or Traffic_Linear) depending on the topology value
you specify in the Network Creation wizard.

Click Next.
The Configuration page appears.

Choose one of the following options from the node type drop-down list:
e MSTP 15454 ONS—To create an MSTP 15454 configuration.
- HYBRID 15454 ONS—To create a 15216 FlexLayer Hybrid configuration.

15216 FlexLayer Hybrid configuration cannot be mixed with the 15454 MSTP configuration. However,
a network can have two clusters one being MSTP and the other 15216 hybrid, without any connection
between the two.
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Note  For PSM Line and PSM Section topologies, the only possible configuration is MSTP 15454 ONS and
the node type drop-down list is disabled.

Step 13 Enter the number of sites in the fields displayed depending on the network topology selected in Step 9.
The following options are available:

Maximum, Minimum, and Default

Network topology Fields to be entered... Number of Sites
Ring or Number of Sites Maximum: 150
Linear Minimum: 2
Default: 3
PSM Line « Intermediate Sites on Working path |Both for working and protected

« Intermediate Sites on Protected path paths:
Maximum: 74
Minimum: 0
Default: 0

PSM Section - Intermediate Sites on Working path |Both for working and protected
paths:

« Intermediate Sites on Protected path
Maximum: 74

Minimum: 0
Default: 0

The maximum number of locations where the optical service channel (OSC) can be terminated in a
network is 150. The maximum number of add/drop locations (equipped with WSS, WXC,
multiplexer/demultiplexer, or OADM cards) traversed by an optical circuit is by default limited to 40.
However, this maximum limit can be customized to 150.

Step 14  On the Site Name and Topology area, choose the topology for each site from the drop-down list.
For multi-degree sites, choose the number of sides from the drop-down list or see 2.2 Adding Sites,
page 2-10.
Available Site Topology options are:

Supported
Structure Configurations Description
Line e MSTP Site with two sides facing two fiber spans. The default site value
15454 ONS |for ring topology is Line.
- HYBRID
15454 ONS
Terminal e MSTP Site with one side facing one fiber span.
15454 ONS
- HYBRID
15454 ONS
Line+ MSTP 15454 Site with two sides facing two fiber spans that can provide
ONS multidegree expansion capability through an MMU unit.
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Supported
Structure Configurations Description
Terminal+ MSTP 15454 Site with one side facing one fiber span that can provide
ONS multidegree expansion capability through an MMU unit.
Terminal+ is not allowed for ring network or linear network
topology intermediate sites.
Multi-degree MSTP 15454 Sites have two or more sides and face two or more fiber spans.
ONS The default is two and you can choose up to eight sides for a site.
PSM Terminal - |MSTP 15454 Provides protection for terminal sites at line level through an
Optical Path ONS optical protection switching module (PSM). In this
Protection configuration, the PSM is directly connected to the fibers after

the amplification stage.

PSM Terminal - |MSTP 15454 Provides protection for terminal sites at multiplex level through

Multiplex ONS an optical protection switching module (PSM). In this
Section configuration the PSM is equipped between the mux/demux
Protection stage and the amplification stage.

The site topology options displayed depend upon the restrictions listed in the following table. See
Table 2-1.

Table 2-1 Site Topology Restrictions

If the Network

Topology is... then...
Ring You cannot choose the following options:
e Terminal

e Terminal+
» PSM Terminal - Optical Path Protection

» PSM Terminal - Multiplex Section Protection

Linear You cannot choose the following options:

- Terminal for the intermediate sites

- Terminal+ for the intermediate sites

» PSM Terminal - Optical Path Protection

» PSM Terminal - Multiplex Section Protection

PSM Line You cannot set any topology for the sites. CTP automatically sets the site
topology as follows:

« PSM Terminal - Optical Path Protection for the two PSM sites
« Line for the intermediate sites

PSM Section You cannot set any topology for the sites. CTP automatically sets the site
topology as follows:

« PSM Terminal - Optical Path Protection for the two PSM sites
- Line for the intermediate sites

Cisco Transport Planner DWDM Operations Guide, Release 9.3
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Step 15

Step 16

Note

Note

Step 17

Step 18

Click Next
The Options area appears.

The Options area allows you to define C-band and L-band rules for the network design. In the Options
area complete the following:

» C-band rules—The C-band options appear in the following format: 80Ch. 50 GHz +1dBm. The
channels available are 80, 72, 64, 40, 32, 20, 16, or 8; the reference per channel power options
available are -1 dBm, +1 dBm, 2 dBm, -2 dBm, +4 dBm, 5 dBm, 7 dBm and 8 dBm; and the spacing
options available are 100 GHz or 50 GHz. You can use even wavelengths for the following channel
designs:

— 80 (40 even wavelengths + 40 odd wavelengths)
— 72 (40 even wavelengths + 32 odd wavelengths)
— 64 (32 even wavelengths + 32 odd wavelengths)

Note  L-band Expand is also supported in the 50 GHz even wavelengths design.

Note  For the HYBRID 15454 ONS configuration, 32 channels is the default value. The channels
available are 8, 16, 20, 32, and 40.

» L-band Rules— The L-band options appear in the following format: 32 Ch. 100 Ghz +5dBm. The
options available are: None, Expand, and channels available are 32; the reference per channel power
available are 2 dBm and 5 dBm; and, the spacing options available is 100 GHz.

L-band is not applicable for the HYBRID 15454 ONS configuration.

If you use a Line+ or Multidegree site, you must select design rules based on 100 GHz channel spacing,
and in the case of Line+, you must also select 32-channel rules. If these conditions are not met,

Cisco Transport Planner will provide an error message when you attempt to analyze the network. See
Table 4-1 and Table 4-2 for additional details on site design rules.

Click Next
The Site Management area appears.

In the Site Management area, complete the following.
» Shelf Management—Choose one of the shelf management configurations:

- Auto—External switch is placed if node controller is M12. If M6 is the node controller, the
external switch is placed only if it is required.

— Multi Shelf Integrated Switch—All the Multi Service Transport Platform (MSTP) optical cards
(optical add/drop multiplexers [ODADMs] and amplifiers) reside in different shelves connected
by a LAN. The LAN is implemented with switches connected to the MSTP shelves. For this
option, the Multi Shelf Integrated Switch Cards (MS-1SC) are used to support the multishelf
configuration.

— Multi Shelf External Switch—All the MSTP optical cards (OADMs and amplifiers) reside in
different shelves connected by a LAN. The LAN is implemented with switches external to the
MSTP shelves (Cisco Catalyst 2950). For this option, two external Ethernet switch units
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(Cisco Catalyst 2950 and Cisco Catalyst 3650) are used to support the multishelf configuration.
The Cisco Catalyst 2950 supports 12 subtending shelves and Cisco Catalyst 3650 supports

24 subtending shelves. CTP supports a maximum of 30 shelves, including the node controller
shelf, in a multishelf configuration.

Note  When the Multi Shelf External Switch is forced, the Multi Shelf External switch is placed
in the layout irrespective of the node controller.

Note  The M6 chassis, when used as node controller, can support three subtended shelves. The
subtended M6 chassis can subtend two more shelves.

— Individual Shelf—All the MSTP optical cards (OADMs and amplifiers) reside in the same shelf.
For this option, the multishelf management is not supported; every shelf is managed as an
independent shelf.

Note  Shelf Management is disabled for HYBRID 15454 ONS configuration.

Note If you select the Shelf Management type as Multi Shelf Integrated Switch or Multi Shelf
External Switch, you can modify the MSM Shelf ID for Multi Shelf Management
Configuration. To modify the MSM Shelf ID, refer “3.2.6 Viewing the Layout of Single
Site” section on page 3-16.

Node Protection—Choose Same Shelf (single shelf configurations) or Separated Shelves
(multishelf configurations). Same Shelf configuration places all the OADM/ROADM units in a
single shelf, and does not provide any protection at the shelf level in the node. Separated Shelves
places OADM/ROADM units (west-facing and east-facing) in separate shelves in the node and it is
selectable only if Multishelf management is selected. You can also set node protection for a
multidegree node.

Note  Node protection is disabled for HYBRID 15454 ONS configuration with an auto-selected
value of Same Shelf.

Hybrid Site Config—Check to create all the nodes configured as hybrid MSTP/Multi Service
Provisioning Platform (MSPP) nodes. Hybrid Node is only available if you chose Individual Shelf
as the Shelf Management type.

OSMINE Compliant—Check this option to place the DWDM units in the shelves according to
Operations Systems Modifications for Integration of Network Elements (OSMINE) placement rules.

DCC Chain—Check to put a TXP(P)_MR_2.5G card in slot 12 on each shelf of each site to use
DCC.

Max Shelves per Rack—Choose the maximum number (from 1 to 4) of ANSI or ETSI shelves
(equipping optical cards or TXP/MXP cards) that can be placed in each rack in the site when
generating the layout of the site.

Installation w/o CTP—Check this box to design a network that does not require the setup of
configuration files (thresholds and setpoints). Installation without Cisco Transport Planner is also
known automatic node turn up. When this feature is enabled, the software in the node will configure
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itself with parameters; XML configuration files are not required to configure the node. When this

option is selected at the end of EDFA and DCU placement, Cisco Transport Planner will analyze the
resulting network and verify that in each node, where the option installation w/o Cisco Transport

Planner is enabled, has:

A preamplifier in each direction.

All amplifiers working in gain control mode.

A flat node output spectrum, that is, the resulting channel tilt at the exit of the node is 0.

A feasible set point forced during simulation.

Use Payg—Check this check box to enable the Pay As You Grow feature on all the sites created in
the current network. For more information about the Pay As You Grow feature, see the
“1.8 Understanding the Pay As You Grow Feature” section on page 1-41.

Step19  Click Next.
The Span Parameters area appears.

Step 20  In the Span Parameters area, complete the following.

Span Label Tag—Enter the desired span label.
Span Fiber Type—Choose the fiber type for each span in the network.

Span Length—Enter the span length. The displayed unit of measure is retrieved from the
Span Measurements Units field.

EOL Ageing Factor—Enter the number to use when factoring fiber aging. This factor is multiplied
by the SOL total span loss without connectors.

EOL Ageing loss [dB]—Enter the EOL aging loss value. The EOL loss-per-span value is added at
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

Note  Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a
value in both fields. Use one of the following formulas to calculate the fiber loss at SOL.:
SOL = km * dB/km + (2 * connector loss)
SOL = user entered loss + (2 * connector loss)
Use one of the following formulas to calculate the fiber loss at EOL.:
EOL = km * dB/km * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss
EOL = user entered loss * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss

Connector loss [dB]—Enter the concentrated loss at the end of the span.

CD factor [ps/mn/km]—Enter the fiber chromatic dispersion (CD) factor. The default value is
dependent on the selected fiber type. Any value that you enter in this field is lost whenever you
change the fiber type. Chromatic dispersion is always entered in ps/nm/km. Fiber chromatic
dispersion is defined for the middle of the wavelength band. C-band is defined at 1545.3 nm and
L-band is defined at 1590.4 nm.

PMD factor [ps/sqrt(km)]—Enter the polarization mode dispersion (PMD) factor. The default value
is dependent on the selected fiber type. Any value that you enter in this field is lost whenever you
change the fiber type. PMD is always entered per kilometer.

Length Based Loss—If this check box is checked, the fiber loss is determined by multiplying the
Span Length with the Loss Factor. If this check box is unchecked, you must enter the total span loss
value for the Tot SOL Loss w/o Connectors property.

Loss factor [dB/km]—Enter the value of the SOL fiber loss per kilometer that is used to calculate
the loss of each span in the network. The fiber loss factor is always entered in dB/km.
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Tot SOL Loss w/o Connectors—Enter the start of life fiber loss value for each span, excluding the
connector concentrated loss.
This property is disabled if the Length Based Loss check box is checked.
DCN extension—Check this check box to use DCN extensions on each of the spans in the network.
This implies that the OSC channel is not used to connect the two nodes. All nodes facing a span with
the DCN Extension option enabled require a ITU-T G.709 generic communications channel (GCC)
access that must be provided by the customer.
Note For HYBRID 15454 ONS configuration, this option is disabled by default.
OSC Frame Type—Choose the OSC frame type. The options available are Auto, OC3 Frame,
GE Frame, and FE Frame. The default option is Auto.
Note CTP does not allow connecting different types of frames through a pass-through site.
CTP does not allow removing a node if different frame types are used in the node.
Step21  Click Finish. CTP checks the validity of the fiber factor values. If the fiber factor values are within the
valid range (Table 2-2), CTP creates a visual representation of the network. If the values are out of range,
CTP issues a warning, asking you to confirm the input values.
Note  All options set by the Network Creation Wizard can be changed as needed per site and per span.
Table 2-2 Valid Ranges for Fiber Factor Values
Min. Min. Max. Max.
Error Warning |Default |Warning |Error
Fiber Type Parameter Value |Value Value Value Value Unit
ITU-T Loss factor 0 0.2 — 0.4 10 dB/km
G.652-SMF Chromatic 0 16.2 16.7 17.1 30 ps/nm/km
dispersion factor
at 1545.3 nm
(C-band)
Chromatic 0 18.53 19.03 19.43 30 ps/nm/km
dispersion factor
at 1590.4 nm
(L-band)
PMD factor 0 0.0 0.1 0.5 10
ITU-T Loss factor 0 0.2 — 0.4 10 dB/km
G.655-E-LEAF | chromatic 0 3.4 3.80 4.2 10 ps/nm/km
dispersion factor
at 1545.3 nm
PMD factor 0 0 0.1 0.5 10
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Table 2-2 Valid Ranges for Fiber Factor Values (continued)
Min. Min. Max. Max.
Error Warning |Default |Warning |Error
Fiber Type Parameter Value |Value Value Value Value Unit
ITU-T Loss factor 0 0.2 — 0.4 10 dB/km
G.655-True Chromatic 0 3.8 4.19 4.6 10 ps/nm/km
Wave dispersion factor
at 1545.3 nm
PMD factor 0 0 0.1 0.5 10
ITU-T Loss factor 0.2 — 0.4 10 dB/km
G.652-DS Chromatic 0 2.43 2.83 3.23 30 ps/nm/km
(D_|sper5|on dispersion factor
shifted) at 1590.4 nm
(L-band)
PMD factor 0 0 0.1 0.5 10

2.2 Adding Sites

Note

Step 1

Step 2

Step 3

Use the following procedure to add new sites to an existing network. A site is a customer premise
equipment (CPE) where any equipment can be co-located in a rack within a building. The

Cisco Transport Planner supports up to 150 sites in a network. The number of racks and nodes in a site
is independent of the number of sites in the network. The maximum number of locations where the OSC
can be terminated in a network is 40. When the number of locations where the OSC is terminated exceeds
the maximum supported value, the tool completes the design, but in the summary report an alarm is reported
to indicate this situation. The maximum number of add/drop locations in a network is 40. The maximum
number of add/drop locations (equipped with WSS, WXC, multiplexer/demultiplexer, or OADM) traversed
by an optical circuit is limited to 40.

Every new site added to a design is automatically configured as Multi-Shelf Integrated Switch with Same
Shelf protection. To change this, you can edit the site properties after adding it to the network design.
See the “4.3 Editing Site Parameters” section on page 4-2.

Right-click the network folder in the Project Explorer pane and choose Expand from the shortcut menu.

Right-click the Sites folder and choose New Site from the shortcut menu. The Site Creation wizard
appears. As an alternative, if sites already exist in the network design and you have the NtView Name
tab open, click the Create a new site icon in the toolbar. For more information about the Cisco Transport
Planner icons, see Appendix A, “GUI Information and Shortcuts.”

Choose the type of node from the Node Type drop-down list. The options available are:
e MSTP 15454 ONS
» HYBRID 15454 ONS
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Step 4

Step 5

Step 6

Adding Fiber Spans

Choose the type of interface from the Select line or terminal site drop-down list. The options available
are:

» Line—Two pairs of fibers are terminated at the node.
- Terminal—A single pair of fibers is terminated at the node.

« Line+—Two pairs of fibers are terminated at the node but the number of fibers can be increased. An
MMU card (topology upgrade) must be installed.

» Terminal+—A single pair of fibers is terminated at the node but the number of fibers can be
increased. An MMU card (topology upgrade) must be installed.

« Multi-degree—Nodes have two or more sides and face two or more fiber spans.

- PSM Terminal - Optical Path Protection—Provides protection for terminal sites at Line level
through an optical protection switching module (PSM). In this configuration, the PSM is directly
connected to the fibers after the amplification stage.

- PSM Terminal- Multiplex Section Protection—Provides protection for terminal sites at multiple
levels through an optical protection switching module (PSM). In this configuration the PSM is
equipped between the mux/demux stage and the amplification stage.

Note Inthe HYBRID 15454 ONS configuration, the supported interface types are line and
terminal.

If you chose multi-degree in Step 4, choose the number of sides from the No of Sides drop-down list.
The default option is two.

Click Finish.

2.3 Adding Fiber Spans

Note

Step 1

Step 2

Step 3

Use the following procedure to manually add fiber spans between sites. A fiber span consists of a pair
of fibers (one transmit and one receive) between two sites. A span is represented by a fiber duct in the
NetViewName tab. Within a fiber duct, more than one fiber pair can exist.

The number of fiber spans that each site can support is defined in the site properties. See the
“2.2 Adding Sites” section on page 2-10 or the “4.3 Editing Site Parameters” section on page 4-2.

In the NtView Name tab, click the Create a new duct icon in the toolbar. For more information about the
Cisco Transport Planner icons, see Appendix A, “GUI Information and Shortcuts.”

Click one of the sites that you want to connect with a fiber span. This site becomes the source site for
later network analysis output.

Click the destination site. This becomes the destination site for later network analysis output. For the
first span, the source site is set as A and the destination site is set as B. Cisco Transport Planner
automatically adjusts East and West for additional spans.

HYBRID 15454 ONS configuration cannot be connected to the 15454 MSTP configuration. However, a
network can have two clusters one being MSTP and the other 15216 hybrid, without any connection
between the two.
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The New Duct dialog box appears.

Note  To connect any two sites using a duct, both the source and destination sites must have at least
one unconnected side.

Step4  Choose the Connection Type:
- Line
« Remote Add/Drop

A Remote Add/Drop duct can be created only between a terminal site and the Remote Add/Drop
side of any non-terminal site.

The remote terminal site to which the remote add/drop side is connected, must fulfill the following
site functionality, type and equipment constraints in addition to the rules in Table 4-1 and Table 4-2:

- Site functionality must be Auto or Add/Drop.
— Site type must be Auto or Mux/Demux.
— Add/Drop units can be 40-MUX-C/40-DMX-C, 15216-MD-40-ODD or 15216-MD-40-EVEN.
For more information see 4.18 Modifying Site Properties, page 4-102.
Step5  Choose the side(s) of the source and destination site to connect.

If you chose Line in Step 4, only the line sides are displayed here. If you chose Remote Add/Drop, the
line side is displayed for the terminal site, while the combo-box of the other site lists the site’s
unconnected Remote Add/Drop ports.

2.4 Creating an Optical Subnet

An optical subnet is a collection of spans with certain associated, defined, common properties. You can
define distinct optical subnets on the same network and can also set a list of associated properties on
each of them.

The following properties are supported in an optical subnet:

» C-band Rules—Allows you to define rules for the C-band channels, the maximum per channel
power, and the channel spacing for the design.

« L-band Rules—Allows you to define, for the L-band channels, the maximum per channel power, and
the channel spacing for the design.

When you create a new project (see 2.1 Creating a Project, page 2-1), Cisco Transport Planner
automatically creates an optical subnet associated to the network. At least one optical subnet (even if
empty) must exist for each network in a project.
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You can create an optical subnet using the Project Options (default) Optical Subnet property (Design
Rules) values. To do this:

Stepl  Select the Optical Subnet folder in the Project Explorer pane. The Optical Subnet Pane appears in the
Task Pane on the right side of the screen (Figure 2-2).

Figure 2-2 Creating Optical Subnet

Step2  Click Create. The Create Optical Subnet dialog box appears (Figure 2-3). Alternatively, right-click the
Optical Subnets folder and select Create.
The default name, which is a combination of the user-created C-band and L-band rules, and the
wizard-created default C-band and L-band rules are displayed.

Figure 2-3 Create Optical Subnet Dialog Box

Cisco Transport Planner DWDM Operations Guide, Release 9.3
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Step3  Select C-band and L-band design rules from the C Design Rule and L Design Rule drop-down lists for
the new optical subnet that you want to create.

Step4  Click OK. A new optical subnet with the design properties you selected is created and placed in project
explorer under the Optical Subnets folder.

Note  You cannot create more then one optical subnet with the same properties values and each span must be
part of only one optical subnet.

Cisco Transport Planner allows you to do the add or remove spans, edit designs rules, define an optical
subnet as current, and to delete an optical network. To do these, select the optical subnet you want to
change under Optical Subnets in the Project Explorer pane. In the Tasks Pane, choose the following:

« Add/Remove Spans—Adds or removes the spans that are included in a given optical subnet.
» Edit Design Rule—Modifies the property value of the design rule of a new or existing optical subnet.
» Set as Current—CTP automatically defines the optical subnet with the greatest number of spans.

- Delete—Deletes the optical subnets in the Tasks Pane.

Note  When you delete an optical subnet, all the spans contained in the deleted optical subnet are placed within
the current optical subnet. In case the current optical subnet is deleted, all their spans will be
automatically placed within the optical subnet with the greatest number of spans. When the current
optical subnet is removed, the tool automatically defines as current the optical subnet with the greatest
number of contained spans.

2.5 Adding Notes to a Project

Use the following procedure to add a note to any item in the Project Explorer pane. Each network has a
Notes folder in the Project Explorer pane. After you have created a note, it appears in the Notes folder
for that particular network.

Step1  Right-click the desired item in the Project Explorer pane and choose Edit Note from the shortcut menu.
Step2  In the Edit Note creation box, enter the desired text.

Step3  To close the Edit Note creation box and to save the note, click the X in the upper right corner of the
window.
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Step 4

Step 5

Creating Traffic Subnet

To view notes, double-click the Notes folder. The Notes window appears. Table 2-3 lists the columns in
the Notes window.

Table 2-3 Notes Window

Column Description

Header Displays the note text. To view the entire note, click the plus (+) sign next to the header
to expand the text.

Action Click Go to open the item in the Project Explorer pane where the note was created.

Source Displays the location of the note, for example, ProjectManager.Nets.Net2.Sites.Site2.W.

To close the Notes window, click the X in the upper right corner of the window.

2.6 Creating Traffic Subnet

Step 1

Step 2

Note

Step 3
Step 4

Step 5

In the Project Explorer pane, scroll down to Traffic Subnets. Right-click Traffic Subnets, and select
Create.

The Traffic Subnet Creation wizard appears.
Select the Topology for the subnet from the drop-down list (Ring, Linear, and Mesh), then click Next.

If Ring or Linear topology is selected for the subnet, the spans in the subnet must be adjacent and also
ordered.

Click Press to build new subnet. The Traffic Subnet Builder Wizard appears (Figure 2-4).

Select the ducts that should be a part of the subnet from the list displayed on the left handside, and click
OK. This takes you back to the Traffic Subnet Creation Wizard.

Click Finish to complete the creation of the traffic subnet. The created subnet appears under Traffic
Subnets in the Project Explorer pane.

[ oL-24717-01
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Figure 2-4 Traffic Subnet Builder Wizard

2.7 Creating a Demand

Cisco Transport Planner provides five types of service demands:
« Point-to-point
» Protected ring (P-ring)
- ROADM
- Ethernet aggregated
- TDM aggregated
You can also create regeneration sites while creating a service demand.

2.7.1 Manual Regeneration

In optical networks, as the fiber length increases, a loss in the signal ratio and power could occur due to
attenuation and dispersion. A regenerator is required to recreate the weak and distorted optical signals
through reamplification, regeneration, and retiming processes. The regenerators remove noise and
distortion, convert the optical signal to an electrical signal, and then convert the signals back to optical
signals (O-E-O conversion).
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Cisco Transport Planner supports the creation of regeneration sites in the network. Regeneration is
supported for the following demands:

» Point-to-point
e P-ring
» Ethernet Aggregated
- TDM Aggregated
The demand is displayed in the following manner:
Demand > Service > Trail > Section
» “Service” is the circuit through which traffic flows between nodes.

- “Trail” is the network section joining two traffic nodes. By default, a trail has only one section. The
trail can be split in different regeneration sections.

- “Section” is a contiguous subset of the span.

A new section is added whenever a regeneration site is created. The sections can have different
wavelengths based on availability. Regeneration can be performed using any two cards back-to-back
(OTU2_XP, TXP, or MXP) or with a dedicated regenerator card.

2.7.2 Understanding Omnidirectional Functionality

The omnidirectional functionality on a side enables you to connect the side to a local multiplexer and
demultiplexer that can add or drop traffic to or from any of the node directions. Omnidirectional traffic
can be added or dropped only on the omnidirectional side.

Omnidirectional sides are different from standard add/drop sides in the following ways:
- Omnidirectional sides are internal sides that cannot be connected through fibers or ducts.

« Amplifiers on omnidirectional sides are placed between the 80-WXC-C card (bidirectional mode)
and the Add/Drop (Mux/Demux) units.

- Raman amplification is excluded on omnidirectional sides, as the amplification depends on the
Raman Amplified option on a duct.

Multi-degree sites that use the OXC functionality and are equipped with the following equipment can
support omnidirectional sides:

- 40-WXC-C/MESH-PP-4
- 40-WXC-C/MESH-PP-8
- 80-WXC-C/MESH-PP-4
- 80-WXC-C/MESH-PP-8
— Flexible (nodes equipped with 80-WXC-C and 40-WXC-C equipment)

Multi-degree sites that use the OXC functionality and are equipped with 40-SMR2-C units, use the
Omnidir Entry Point option to implement the omnidirectional functionality. Multi-degree OXC sites
equipped with 40-WXC-C units can support both omnidirectional sides and the Omnidir Entry Point
options. However, both options cannot be used on the same side.

For more information see the“Modifying Site Properties” section on page 102.
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2.7.2.1 Omnidirectional Demands

In all service demands (except ROADM demands), the value of the omnidirectional property is
independent for each section or trail of a service.

You can perform operations at the trail level. The following are some examples:

- Terminate a working trail on the omnidirectional stage, and connect the protected trail to a standard
add/drop stage.

- Terminate a trail on a line side and regenerate the trail in an intermediate omnidirectional side.

» Force both working and protected trails (or consecutive trails in the case of a P-Ring demand) to
terminate on the same omnidirectional side. By default, traffic from all demands (except ROADM
demands) terminates on two different omnidirectional sides.

The omnidirectional property is available for the source and destination of each section of a service trail.
A section terminating on an omnidirectional side can be routed in all possible directions. If multiple
omnidirectional sides are available for a site, you can force the section to terminate on a specific side.

2.7.3 Understanding Colorless Functionality

The colorless property enables tuning of channel wavelengths without changing the optical interface of
the port. A colorless side is connected to two 80-WXC-C cards configured as a multiplexer and
demultiplexer.

A colorless stage is available at the local add/drop stage on line, terminal, or multi-degree sites.
In line and terminal sites, you can implement colorless sides using the following configurations:

« Line or terminal ROADM site with 80-WXC-C cards

Note  For line sites, you must have 80-WXC-C cards on both sides even when only one of the ports is
forced as colorless.

« Line or terminal sites equipped with 40-SMR1-C
« Line or terminal sites equipped with 40-SMR2-C

In multi-degree sites you can implement colorless sides through a node having OXC functionality and
are equipped with the following:

« 40-WXC-C/MESH-PP-4
« 40-WXC-C/MESH-PP-8
. 80-WXC-C/MESH-PP-4
« 80-WXC-C/MESH-PP-8
. 40-SMR2-C
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2.7.3.1 Colorless Demands

In all service demands (except ROADM) the colorless property is available separately for each trail and
section of a service demand.

For example, in a P-ring demand you can terminate one trail on a colorless mux/demux stage and connect
the other trail to a standard (colored) mux/demux stage.

Colorless sections must be associated to an 80-WXC-C colorless port and can be terminated on sides
having colorless add/drop ports to achieve full wavelength tuning capability on fixed physical ports.

2.7.4 Understanding Colorless Omnidirectional Functionality

Note

A colorless and omnidirectional side is connected to a multiplexer (80-WXC-C card) and demultiplexer
(80-WXC-C card) that can add or drop traffic to or from any of the node directions. You can define an
omnidirectional colorless side by adding one or more colorless ports to an omnidirectional side.

In all service demands (except ROADM), you can configure colorless termination points as
omnidirectional, to achieve full routing capability for all possible wavelengths.

In a 50GHz design, an omnidirectional demand can be dropped only on a colorless omnidirectional side.

2.7.5 Creating a Point-to-Point Demand

Step 1

Step 2
Step 3
Step 4

Step 5

Step 6

Use the following procedure to add a point-to-point traffic demand:

In the NtView Name tab, click the Create new Point-to-Point demand icon in the toolbar. For more
information about the Cisco Transport Planner icons, see Appendix A, “GUI Information and
Shortcuts.”

Click the source site of the demand.
Click the destination site of the demand. The Point to Point Demand Creation Wizard appears.

From the drop-down list, select Traffic Subnet ALL or any of the previously created traffic subnets to
which this service demand should be part of, and proceed to Step 5. If you wish to create a new traffic
subnet see “2.6 Creating Traffic Subnet” section on page 2-15.

Click Next.

On the General Parameters page, complete the following:
- Label—Enter the name of the demand.
» Source—(Display only) Displays the source site name.
- Destination—(Display only) Displays the destination site name.

» Service Type—Choose the service type from the drop-down list. For a list of services, see the
“1.1.2.5 Service Support” section on page 1-7.

« Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically
updates with the number entered in this field.

« Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two
channels in the future, enter 6.
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Step7  Click Next. The Platform Parameters page appears.
Step8  On the Platform Parameters page, complete the following in the Platform area:

» Protection—Choose the protection type from the drop-down list: Client 1+1, Y-Cable, Fiber
Switched, PSM-OCH, or Unprotected. For more information on protection types, see the
“1.1.2.4 Protection Scheme Support” section on page 1-5.

» Path—(Unprotected only) Choose the routing type from the drop-down list:

- Auto—Allows the highest degree of flexibility in routing the channels. Cisco Transport Planner
routes the channels with the lowest possible cost, given the other constraints.

— A—Select this for a Terminal or a Terminal+ site.
— A or B—Select either of these for a Line or a Line+ site.
- A, B, C, or D—Select either of these for a Multidegree site if four ducts are connected.

- A,B,C,D,E,F, G, or H—Select either of these for a Multidegree site if eight ducts are
connected.

— Aw or Ap—Select either of these for a PSM Terminal - Optical Path Protection or PSM Terminal
- Multiplex Section Protection site.

« Optical Bypass—(Unprotected only) Choose the site where the channels for the current demand will
be optically bypassed. A channel in optical bypass is dropped on one side of the node and added on
the other side of the same node to allow the future use of that node as an add/drop location.

« Colorless— Choose an option from the colorless drop-down list. For more information on colorless
property see “2.7.3 Understanding Colorless Functionality” section on page 2-18.

- Auto—(Default) Disables colorless functionality on the demand.
- Yes—Enables colorless functionality on the demand.
— No—Disables colorless functionality on the demand.

« Omni-directional— Choose an option from the Omni-directional drop-down list. For more
information on omnidirectional property see “2.7.2 Understanding Omnidirectional Functionality”
section on page 2-17.

- Auto—(Default) Dynamically enables omnidirectional functionality on a colorless demand,
when the colorless demand needs to be dropped on an omnidirectional side with colorless ports,
due to lack of any other colorless port on the side.

- Yes—Enables omnidirectional functionality on the demand.
- No—Disables omnidirectional functionality on the demand.

Step9  In the Platform Parameters page, complete the following fields in the Interface/Card Type area. The
options available are based on the service type selected in Step 6.

- Transponder—Click to expand, then check the Card Type check box to select the card at the end
sites of the service channels.

If you have selected the Service Type as LAN-WAN Conversion in Step 6, when you expand
Transponder, select any one of the following OTU2-XP LAN-WAN modes and then proceed to step
Step 10:

- OTU2-XP- Mixed Mode—Select the card type as OTU2-XP Mixed Mode if the Protection type
is either Unprotected, Client 1+1, or PSM-OCH.

— OTU2-XP- Txp Mode—Select the card type as OTU2-XP Txp Mode if the Protection type is
either Unprotected, Client 1+1, or PSM-OCH.

Cisco Transport Planner DWDM Operations Guide, Release 9.3
m. oL-24717-01 |



| Chapter2

Creating and Analyzing Networks

Step 10

Step 11

Step 12

Step 13
Step 14

Step 15
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— OTU2-XP- Splitter Mode—Select the card type as OTU2-XP Splitter Mode if the Protection
type is Fiber-Switched.

Note  Y-cable protection is not supported on the LAN to WAN interface (ports 1 and 3)

» Line Card—Click to expand, then check the Card Type check box to select the card at the end sites
of the service channels.

« Alien Card—Appears only if you created a third-party interface as described in the “1.6.5 Defining
Third-Party DWDM Interfaces” section on page 1-33. Click to expand, and then check the card type
check box to select the card at the end sites of the service channels.

» Pluggable Card—Click to expand, then check the card type check box to select the card at the end
sites of the service channels.

In the Client Interface area, define the client interface type for the source (SR, ZR, ER, or LR) and
destination (EW, SW, or LW) from the Source and Destination drop-down list. This option is available
for transponder and muxponder interfaces that have pluggable client interfaces that depend on the
selected service type and card type.

Note  Inthe LAN-WAN conversion mode, CTP automatically selects the Source and Destination client
interface type if you have not selected the Source and Destination client interface type.

Click Finish. The Demand Editor dialog box appears listing the present and forecast channels.

The demand appears in the NtView name tab and in the Project Explorer pane in the

Service Demands > Point To Point folders. A demand is a solid line when selected and a dotted line when
not selected. The line has a number above it that indicates the number of channels that are present.
Figure 2-5 shows a selected point-to-point demand with five channels between sites 1 and 2.

Figure 2-5 Point-to-Point Demand Between Two Sites

To add a new service, click the Add new service icon in the toolbar. A new row appears. Complete the
parameters for the new channel.

To delete an existing channel, select the row and click the Delete service icon in the toolbar.

To set path constraints, click the Path Constraints Editor icon in the toolbar and complete the following
as required:

« Output Node Interface—Choose from the drop-down list, the side through which the demand must
be routed.

« Exclude Sites—Choose the sites that must be excluded from the demand route.
« Exclude Ducts—Choose the ducts that must be excluded from the demand route.
Click OK to save the changes and Cancel to close the dialog box without saving the changes.

This icon is available only at the trail level of the service demand.
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Step 16

Step 17

Note

Note

To add a regeneration site, click the Regeneration... icon in the toolbar. The Regeneration editor
appears. The regeneration site can be created only at the trail level. For more information, see the
“2.7.10 Creating a Regeneration Site” section on page 2-41.

Click OK to save the changes to the channels and close the Demand editor dialog box, or Cancel to close the
dialog box without saving the changes.

To make changes to the demand parameters, see the “4.7 Editing a Point-to-Point Demand” section on
page 4-41, or click Cancel to close the Demand Editor dialog box.

For each network, Cisco Transport Planner automatically creates a default subnet that exactly matches
the overall network topology. This cannot be deleted.

2.7.6 Creating a Protected Ring Demand

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

Use the following procedure to create a P-ring traffic demand.

Create a ring network using either the procedures in 2.1 Creating a Project, page 2-1or by manually
placing sites into a ring configuration.

In the Native Net# tab, click the Create new P-Ring demand icon in the toolbar. The P-Ring Creation
Wizard appears. For more information about the Cisco Transport Planner icons, see Appendix A, “GUI
Information and Shortcuts.”

For each network, the tool automatically creates, a default subnet that exactly matches the overall
network topology. This cannot be deleted. From the drop-down list, select any previously created traffic
subnet with a ring topology that this circuit should be part of and proceed to Step 4. If you wish to create
a new traffic subnet see 2.6 Creating Traffic Subnet, page 2-15.

On the General Parameters page, complete the following:
« Label—Enter the name of the demand.

- Service Type—Choose the service type from the drop-down list. For a list of services, see the
“1.1.2.5 Service Support” section on page 1-7.

« Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically
updates with the number entered in this field.

« Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two
channels in the future, enter 6.

Click Next.

On the Sites Selection page, in the Protection Sites area, press Ctrl and click the sites that you want to
add to the P-ring. A P-ring requires at least two sites. Click the right arrow button. To remove a site added
to the list, click the site and click the left arrow button.

In the Optical Bypass area, press Ctrl and click the sites that you want to add to the P-ring. Click the
right arrow button. To remove a site added to the list, click the site and click the left arrow button.

Click Next. The WDM Client Selection page appears.
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Step8  Onthe WDM Client Selection page, enter the following Platform Parameters:

Colorless— Choose an option from the colorless drop-down list. For more information on colorless
property see “2.7.3 Understanding Colorless Functionality” section on page 2-18.

- Auto—(Default) Disables colorless functionality on the demand.
— Yes—Enables colorless functionality on the demand.
— No—Disables colorless functionality on the demand.

Omni-directional— Choose an option from the Omni-directional drop-down list. For more
information on omnidirectional property see “2.7.2 Understanding Omnidirectional Functionality”
section on page 2-17.

- Auto—(Default) Dynamically enables omnidirectional functionality on a colorless demand,
when the colorless demand needs to be dropped on an omnidirectional side with colorless ports,
due to lack of any other colorless port on the side.

- Yes—Enables omnidirectional functionality on the demand.

- No—Disables omnidirectional functionality on the demand.

Step9  Complete the following in the Interface/Card Type area. The options available are based on the service
type selected in Step 4.

Transponder—Click to expand, then check the Card Type check box to select the card at the end
sites of the service channels.

If you have selected the Service Type as LAN-WAN Conversion in Step 4, when you expand
Transponder, select any one of the following OTU2-XP LAN-WAN modes:

- OTU2-XP- Mixed Mode—Select the card type as OTU2-XP Mixed Mode if the Protection type
is either Unprotected, Client 1+1, or PSM-OCH.

— OTU2-XP- Txp Mode—Select the card type as OTU2-XP Txp Mode if the Protection type is
either Unprotected, Client 1+1, or PSM-OCH.

— OTU2-XP- Splitter Mode—Select the card type as OTU2-XP Splitter Mode if the Protection
type is Fiber-Switched.

Line Card—cClick to expand, then check the card type check box to select the card at the end sites
of the service channels.

Alien Card—Appears only if you created a third-party interface as described in the “1.6.5 Defining
Third-Party DWDM Interfaces” section on page 1-33. Click to expand, and then check the card type
check box to select the card at the end sites of the service channels.

Pluggable Card—Click to expand, then check the card type check box to select the card at the end
sites of the service channels.

In the Client Interface area, define the client interface type for the source (SR, ZR, ER, or LR) and
destination (EW, SW, or LW) from the Source and Destination drop-down list. This option is available
for transponder and muxponder interfaces that have pluggable client interfaces that depend on the
selected service type and card type.

Note  Inthe LAN-WAN Conversion mode, CTP automatically selects the Source and Destination

client interface type if you have not selected the Source and Destination client interface type.

[ oL-24717-01
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Step 10

Step 11

Step 12
Step 13

Step 14

Note

Click Finish. The Demand Editor dialog box appears.

The demand appears in the NtView name tab and in the Project Explorer pane in the

Service Demands > P-Rings folders. A demand is a solid line when selected and a dotted line when not
selected. The line has a number above it that indicates the number of channels present. Figure 2-6 shows
a selected one-channel P-ring between sites 1, 2, 3, and 5 with an optical bypass of site 4.

To add a new service, click the Add new service icon in the toolbar. A new row appears. Complete the
parameters for the new channel.

To delete an existing channel, select the row and click the Delete service icon in the toolbar.

To add a regeneration site, click the Regeneration... icon in the toolbar. The Regeneration editor
appears. The regeneration site can be created only at the trail level. For more information, see the
“2.7.10 Creating a Regeneration Site” section on page 2-41.

Click OK to save the changes to the channels and close the Demand Editor dialog box, or Cancel to close
the dialog box without saving the changes.

To make changes to the demand parameters, see the “4.8 Editing a P-Ring Demand” section on
page 4-44, or click Cancel to close the Demand Editor dialog box.

Figure 2-6 P-Ring Demand
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2.7.7 Creating a ROADM Demand

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6

Step 7

Step 8
Step 9

Note

Use the following procedure to create ROADM traffic groups and demands:

In the Project Explorer pane, under Nets, right-click the ROADM folder and choose New ROADM
Group. The ROADM Group Creation Wizard appears.

Select the desired traffic subnet from the Traffic Subnet field. You can create a new traffic subnet if
desired using the “2.6 Creating Traffic Subnet” section on page 2-15.

Enter the ROADM traffic group name in the Group Name field.
Check the desired sites.

Click Finish. The new ROADM traffic group appears under the ROADM folder in the Project Explorer
pane.

Right-click the new ROADM traffic group and choose Create new ROADM demand from the shortcut
menu. The Create ROADM Demand dialog box appears (Figure 2-7).

Figure 2-7 Create ROADM Demand Dialog Box

(Optional) If you copied properties of an existing ROADM demand, click Use Template to use the
properties of the copied ROADM demand.

Enter a name for the demand in the Demand Name field.

Select a traffic pattern type (Hub, Meshed, or Ring) from the Traffic Type drop-down list:
- Hub—If you select Hub, select the originating site from the First Site drop-down list.
» Meshed—If you select Meshed, go to Step 10.

- Ring—If you select Ring, select Routing Strategy as either Unprotected Minimum Hop,
Unprotected Optimum Path, or Unprotected Subnet, and proceed to Step 11

Refer to the “1.1.5.3 ROADM Traffic Demands” section on page 1-13 for more information on the
connectivity choices.

[ oL-24717-01
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Step 10

Step 11

Step 12

Step 13

Note

Step 14

Note

Step 15

Select a routing strategy from the Routing Strategy drop-down list: Protected, Unprotected Minimum
Hop, Unprotected Optimum Path, or Unprotected Subnet. If you chose Unprotected Subnet, continue
with the next step; otherwise proceed to Step 12.

If you chose Unprotected Subnet, choose the starting site and the direction the ring must be traversed
from the drop-down lists.

In the Service Types list, check the boxes for one or more client service types for the ROADM demand.
The client interfaces that support each service type appear in the table to the right of the Service Types

list.

Check the OmniDirection check box to enable the omnidirectional property for the ROADM demand.

The omnidirectional property is applied to the unprotected ROADM demand only when all the sites
in the ROADM group have a minimum of one omnidirectional side with two colorless ports on each
side.

The omnidirectional property is applied to the protected ROADM demand only when all the sites in
the ROADM group has minimum two omnidirectional sides with two colorless ports on each side.

When the ROADM demand is finalized, CTP shows the omnidirectional property as Yes irrespective
of the source or destination.

Check the Colorless check box to enable the colorless property for the ROADM demand.

The colorless property is applied to the unprotected ROADM demand only when one line side with
one colorless port is available in each site.

The colorless property is applied to the protected ROADM demand only when two line sides with
one colorless port are available in each site.

If there are no colorless ports on the line side but available on the omnidirectional side, CTP displays
an error message.

When the ROADM demand is finalized, CTP shows the colorless property as Yes irrespective of the
source or destination.

To further define the client interfaces, complete the following options for each client interface listed in
the table. Check boxes in gray are not available for selection.

Yes/No—Check to select this card to implement the service type.

Client Interface—(Display only) Displays the card type for the selected service type.

Y Protected—Check to select Y-cable protection if the connectivity type is Protected.

1+1 Protected—Check to select 1+1 protection if the connectivity type is Protected.

Fiber Switched—Check to select fiber-switching protection if the connectivity type is Protected.
Supported Service—(Display only) Displays the service types supported for the card.

You can select more than one client interface to support the same service type. By default,
Cisco Transport Planner checks the best client interface to support each service.
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Step 16  Click OK to create the demand. Figure 2-8 shows an example of ROADM Demand.

Figure 2-8 ROADM Demand

Step 17 Copy ROADM demand properties. The following properties are copied:
- Traffic Type
» Routing Strategy
« Service Types
- OmniDirection
- Colorless
- DWDM Card Interface table (Yes/No, Client Interface, and Protection Type columns)

These properties can be used as a template while creating a new ROADM demand or editing an existing
one. To copy the properties, select the ROADM demand, right-click, and choose the Copy Properties
option. When the ROADM demand properties are copied, the Use Template button is enabled in the
Create ROADM Demand and Edit ROADM Demand dialog boxes.

Note « The Copy Properties option is not available when you log out of the CTP session.

« ROADM demand properties copied from Release 8.5 and later can be used in an upgraded network
up to Release 9.3.

- ROADM demand properties copied in the later releases (for example, Release 9.3) is not available
in the earlier releases (for example, Release 9.1).

Step 18  To finalise the ROADM demand, complete the following steps:
a. Analyse the network.
b. Upgrade the analysed network.

c. Inthe upgraded network, go to the card listed under the ROADM demand, select the required
connectivity (for example, Sitel - Site2), right-click and select the Finalize connectivity option. The
ROADM Finalise Connectivity Wizard appears.

Cisco Transport Planner DWDM Operations Guide, Release 9.3
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On the General Parameters page, complete the following:
Label—Enter the name of the demand.

Service Type—Choose the service type from the drop-down list. For a list of services, see the
“1.1.2.5 Service Support” section on page 1-7.

Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically
updates with the number entered in this field.

Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the
Present # ch value.

In the Platform area of the Platform Parameters page, complete the following:

Protection—Choose the protection type from the drop-down list: Y-Cable Protected, or Client 1+1.
For more information on protection types, see the “1.1.2.4 Protection Scheme Support” section on
page 1-5.

In the 454DWDM area, complete the following:

Transponder—Click to expand, then check the card type check box to select the card at the end sites
of the service channels.

In the Client Interface area, define the client interface type (SR, IR, or LR) for the source and
destination from the Source and Destination drop-down lists. This option is available for
transponder and muxponder interfaces that have pluggable client interfaces that depend on the
selected service type and card type.

Click Finish. The Demand Editor dialog box appears listing the present and forecast channels.

To add a new service, click the Add new service icon in the toolbar. A new row appears. Complete
the parameters for the new channel.

To delete an existing channel, select the row and click the Delete service icon in the toolbar.

To add a regeneration site, click the Regeneration... icon in the toolbar. The Regeneration editor
appears. The regeneration site can be created only at the trail level. For more information, see the
“2.7.10 Creating a Regeneration Site” section on page 2-41.

Click OK to save the changes to the channels and close the Demand editor dialog box, or Cancel to close
the dialog box without saving the changes.

Analyse the upgraded network again.

The demands that were finalized appear in the reports.

2.7.8 Creating Ethernet Aggregated Demands

An Ethernet aggregated demand is a collection of low-rate Gigabit Ethernet/10Gigabit Ethernet services
that can be aggregated on a single 10-Gbps wavelength division multiplexing (WDM) trunk. This
demand is supported only by the GE_XP, 10GE_XP, GE_EXP, and 10GE_EXP cards when configured
as an L2-Switch.

The Ethernet Aggregation Creation wizard allows you to:

Create one WDM transport channel at a time over a predefined traffic subnet.

Specify the wavelength to be used for the channel, and define a list of locations with add/drop VLAN
circuit capability.
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Create a set of desired VLAN circuits on this WDM transport channel.

The check functionality generates a report showing for each section of the subnet where the WDM
transport channel is over allocated and then perform corrective action when required.

The clone functionality creates an identical copy of the current WDM transport channel with the
same add/drop sites and WDM channel configuration parameters. You can then start filling this
channel with the desired circuits.

Use the following procedure to create Ethernet aggregated demands:

In the NtView name tab, click the Create new AggregatedEthernet demand icon in the toolbar. For
more information about Cisco Transport Planner icons, see Appendix A, “GUI Information and
Shortcuts.” The EthernetAggr Creation Wizard appears.

Choose the desired traffic subnet from the Traffic Subnet drop-down list. You can create a new traffic
subnet if desired (see 2.6 Creating Traffic Subnet, page 2-15).

Click Next. The General Parameters page appears.

In the General Parameters pane, enter values in the following fields:

Label—Enter the name of the demand. The default value is EthernetAggrl.

Present/Forecast—Check this box if this demand will be needed in the future; uncheck this box if
this demand is needed now. This parameter drives the list of pluggable port modules to be equipped
on the card and will affect BoM reports.

Colorless— Choose an option from the colorless drop-down list. For more information on colorless
property see “2.7.3 Understanding Colorless Functionality” section on page 2-18.

- Auto—(Default) Disables colorless functionality on the demand.
- Yes—Enables colorless functionality on the demand.
— No—Disables colorless functionality on the demand.

Omni-directional—Choose an option from the Omni-directional drop-down list. For more
information on omnidirectional property see “2.7.2 Understanding Omnidirectional Functionality”
section on page 2-17.

- Auto—(Default) Dynamically enables omnidirectional functionality on a colorless demand,
when the colorless demand needs to be dropped on an omnidirectional side with colorless ports,
due to lack of any other colorless port on the side.

- Yes—Enables omnidirectional functionality on the demand.

— No—Disables omnidirectional functionality on the demand.

Click Next.
In the Sites selection pane, complete the following tasks:

In the Protection Sites area, press Ctrl and click the sites that you want to add to the Ethernet
aggregated demand. An Ethernet aggregated demand requires at least two sites. Click the right arrow
button. To remove a site added to the list, click the site and click the left arrow button.

In the Optical Bypass area, press Ctrl and click the sites that you want to add to the Ethernet
aggregated demand. Click the right arrow button. To remove a site added to the list, click the site
and click the left arrow button. If the Present/Forecast check box is checked, you cannot select
Optical Bypass sites. A channel in optical bypass is dropped on one side of the node and added on
the other side of the same node to allow the future use of that node as an add/drop location.

[ oL-24717-01
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Step7  In the Node Configuration selection pane, enter values for the following options:

- DWDM Trunk—Select the DWDM trunk type. You can specify the kind of WDM trunk interface
for the card in each add/drop site. Allowed values are:

Auto
W/EFEC
w/FEC
w/o FEC

» Wavelength—Select the WDM transport channel wavelength. This option allows you to force the
current WDM transport channel wavelength. Wavelengths are listed based on the selected band.
Allowed values are:

Auto—Allows CTP to assign a wavelength to the channel with the lowest possible cost, given the
other set of constraints.

C band-32 ch.odd
L band- 32 ch.odd
C band- 40 ch
C band- 64 ch
C band-72 ch
C band- 80 ch

» New CFG—Choose the desired card type for each of the protected sites.

Step8  Click Finish. The name Demand window appears (Figure 2-9).

Figure 2-9 EthernetAggrl Demand Window, TrafficTab

Step9  Click Close.
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Step 10  To add a circuit, right-click the Ethernet Demand in the Project Explorer pane and choose New point to
point request. The New Request window appears (Figure 2-10).

Figure 2-10 New Request Window

Step 11  The New Request window contains four areas of information: Quantity, General, Src, and Dest.

Quantity Area
Quantity—Enter the number of circuits to be created.

General Area
» Label—Enter the label for the circuit. By default, VLAN_Circuit_x is used.

» Trunk Protection—Enter the trunk protection type. Allowed values are:
— Unprotected
— Protected

- P/F—Select Forecast if this demand will be needed in the future. Select Present if this demand is
needed now. This parameter drives the list of pluggable port modules to be equipped on the card and
affects BoM reports.

[ oL-24717-01
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- Path Forcing—This option allows you to force the circuit routing on the traffic subnet associated
with this demand. Allowed values are:

- Auto—(Default) Causes the tool to automatically define the trunk path.

— Side x—Represents the label of the side on the Src site where the circuit is routed.
« Client Protection—Allowed values are:

— Unprotected

- Client 1+1

» Circuit rate—Displays the allowed circuit rates.

Src Area

« Site—Select the source site. Allowed values include the list of sites added in the WDM traffic
channel.

« SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.

» Card—Select the Card. Allowed values are Auto, 10GE-XP, 10GE-EXP, GE-XP, and GE-EXP. Auto
allows the tool to select an appropriate card type based on other constraints.

The Src area contains Working and Protected subareas.
Working sub-area

» Port CIR—Select the Committed Information Rate (CIR), with 1 being the highest and 0.1 being the
lowest.

- Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

« Port Num—Select the port number. Allowed values are Auto, 1, and 2. Auto allows the tool to select
an appropriate port number based on other constraints.

Protected sub-area
These fields are enabled only if client protection is enabled in the Client Protection field.
» Port CIR—Select the CIR, with 1 being the highest and 0.1 being the lowest.

- Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

» Port Num—Select the port number. Allowed values are Auto, 1, and 2. Auto allows the tool to select
an appropriate port number based on other constraints.

Dest Area

« Site—Select the destination site. Allowed values include the list of sites added in the WDM traffic
channel.

» SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.

« Card—Select the card. Allowed values are Auto, 10GE-XP, 10GE-EXP, GE-XP, and GE-EXP. Auto
allows the tool to select an appropriate card type based on other constraints.

The Dest area contains Working and Protected subareas.
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Working sub-area
» Port CIR—Select the CIR, with 1 being the highest and 0.1 being the lowest.
- Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.
- Port Num—Select the port number. Allowed values are Auto, and 1 to 20. Auto allows the tool to
select an appropriate port number based on other constraints.
Protected sub-area
These fields are enabled only if the client protection is enabled in the Client Protection field.
» Port CIR—Select the CIR, with 1 being the max and 0.1 being the lowest.
- Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.
» Port Num—Select the port number. Allowed values Auto, 1, to 20. Auto allows the tool to select an
appropriate port number based on other constraints.

Step12 Click OK.

Step 13 The Traffic tab displays the following details about the circuit:

« AL—Displays the alarm (if any) for the circuit.

« Label—Displays the name of the circuit.

- F—If checked, it is a forecast circuit. If unchecked, it is a present circuit.
- Src Site—Displays the source site.

- Dst Site—Displays the destination site.

» Rate—Displays the circuit rate/bandwidth.

« Client Prot—Displays the client protection scheme.

« Trunk Prot—Displays the trunk protection scheme.

- Message—Displays a message related to the circuit.

Step 14 If you want to clone this demand, click the Clone button in the left corner of the screen. A new demand,
which is a copy of this demand, is created and appears in the Project Explorer pane.

Step 15  Click the Check tab in the left corner of the window to generate a report showing the circuit path in the
WDM traffic channel and to check any over-allocation of bandwidth (Figure 2-11). The Report tab
displays, in a row, each of the sites on the subnet, and each span in between.
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Figure 2-11 Circuit Path View in a Ethernet Aggregated Demand

Step 16  The Traffic Result tab displays the following:
« Label—Displays the name of the circuit.
« F—If checked, it is a forecast circuit. If unchecked, it is a present circuit.
» Src Site—Displays the source site.
- Dst Site—Displays the destination site.
» Trunk Protection—Displays the trunk protection scheme.

» Path Forcing—Displays the output Node interface. If no client or trunk protection is used, displays
NA.

« Client Protection—Displays the client protection scheme.

« Circuit Rate—Displays the circuit rate/bandwidth.

« Src Wrk Port Num—Displays the source working port number.

» Src Prt Port Num—Displays the source protect port number.

» Dst Wrk Port Num—Displays the destination working port number.

« Dst Prt Port Num—Displays the destination protect port number.

« Src Wrk Port CIR—Displays the source working port CIR. The highest is 1 and 0 the lowest.

« Src Prt Port CIR—Displays the source protect port CIR. The highest is 1 and 0 the lowest.

- Dst Wrk Port CIR—Displays the destination working port CIR. The highest is 1 and 0 the lowest.
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» Dst Prt Port CIR—Displays the destination protect port CIR. The highest is 1 and 0 the lowest.

» Src Wrk Port Rate-Reach—Displays the PPM for the source working port. For example, Rack
1.Shelf 1. Slot 5.

« Src Prt Port Rate-Reach—Displays the PPM for the source protect port. For example, Rack 1.Shelf
1. Slot 4.

» Dst Wrk Port Rate-Reach—Displays the PPM for the destination working port.
» Dst Prt Port Rate-Reach—Displays the PPM for the destination protect port.

» Src Card—Displays the source card.

- Dst Card—Displays the destination card.

» Working Src Card Rack-Shelf-Slot—Displays the rack, shelf, and slot position of the working
source card.

» Working Dst Card Rack-Shelf-Slot—Displays the rack, shelf, and slot position of the working
destination card.

» Protecting Src Card Rack-Shelf-Slot—Displays the rack, shelf, and slot position of the protect
source card.

« Protecting Dst Card Rack-Shelf-Slot—Displays the rack, shelf, and slot position of the protect
source card.

« Alarm—Displays the alarm status.

To add a regeneration site, click the Regeneration... icon in the toolbar of the DWDM channel tab. The
Regeneration Editor appears. The regeneration site can be created only at the trail level. For more
information, see the “2.7.10 Creating a Regeneration Site” section on page 2-41.

Click Close. To edit circuits, see the “4.10 Editing an Ethernet Aggregated Demand” section on
page 4-48.

2.7.9 Creating TDM Aggregated Demands

A TDM aggregated demand is a collection of low-rate SONET and Gigabit Ethernet services that is
aggregated on a single 10-G WDM trunk. The TDM aggregated demand is a specific service demand that
is carried only by the ADM-10G card.

The TDM Aggr Creation wizard allows you to:
« Create one WDM transport channel at a time over a predefined traffic subnet

» Specify the wavelength to be used for the channel, and define a list of locations with add/drop STS
circuit capability.

» Create a set of STS circuits on this WDM transport channel to pass traffic.

» The check functionality generates a report showing, for each section of the subnet, where the WDM
transport channel is over allocated and then perform, when required, the corrective action.

The total amount of bandwidth used by all the defined circuits in each section of the WDM transport
channel cannot exceed the maximum channel capacity of STS-192c. Sections exceeding the maximum
capacity are colored red in the report. Demands that fail the check are flagged as invalid demands and
the Analyzer stops.

[ oL-24717-01
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Step 1

Step 2

Step 3
Step 4

Step 5
Step 6

The clone functionality allows you to create an empty copy of the current WDM transport channel, with
the same add/drop sites and WDM channel configuration parameters. You can then start filling this
channel with the desired circuits.

Use the following procedure to create TDM aggregated demands:

In the NtView name tab, click the Create new TDM Aggregated demand icon in the toolbar. For more
information about CTP icons, see Appendix A, “GUI Information and Shortcuts.”
The TDMAggr wizard appears.

Select the desired traffic subnet from the Traffic Subnet drop-down list. You can create a new traffic
subnet if desired using (see 2.6 Creating Traffic Subnet, page 2-15).

Click Next. The General Parameters page appears.
In the General Parameters pane, complete the following tasks:
« Label—Enter the name of the demand. The default value is TDMAggrl.

« Present/Forecast—Check this box if this demand will be needed in the future; uncheck this box if
this demand is needed now. This parameter drives the list of pluggable port modules to be equipped
on the card and will affect BoM reports.

» Colorless— Choose an option from the colorless drop-down list. For more information on colorless
property see “2.7.3 Understanding Colorless Functionality” section on page 2-18.

- Auto—(Default) Disables colorless functionality on the demand.
- Yes—Enables colorless functionality on the demand.
— No—Disables colorless functionality on the demand.

e Omni-directional— Choose an option from the Omni-directional drop-down list. For more
information on omnidirectional property see “2.7.2 Understanding Omnidirectional Functionality
section on page 2-17.

”

- Auto—(Default) Dynamically enables omnidirectional functionality on a colorless demand,
when the colorless demand needs to be dropped on an omnidirectional side with colorless ports,
due to lack of any other colorless port on the side.

- Yes—Enables omnidirectional functionality on the demand.
- No—Disables omnidirectional functionality on the demand.
Click Next.
In Sites selection pane, complete the following tasks:

« In the Protection Sites area, press Ctrl and click the sites that you want to add to the TDM
aggregated demand. A TDM aggregated demand requires at least two sites. Click the right arrow
button. To remove a site added to the list, click the site and click the left arrow button.

« In the Optical Bypass area, press Ctrl and click the sites that you want to add to TDM aggregated
demand. Click the right arrow button. To remove a site added to the list, click the site and click the
left arrow button. If the Present/Forecast check box is checked, you cannot select Optical Bypass
sites. A channel in optical bypass is dropped on one side of the node and added on the other side of
the same node to allow the future use of that node as an add/drop location.
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Step7  In the Node Configuration selection pane, complete the following tasks:

- DWDM Trunk—Select the DWDM trunk type to specify the kind of WDM trunk interface for the
card in each allowed add/drop site. Allowed values are:

Auto
W/EFEC
w/FEC
w/o FEC

» Wavelength—Allows you to force the current WDM transport channel wavelength. Allowed values

are:

Auto—Allows CTP to assign a wavelength to the channel with the lowest possible cost, given the
other set of constraints.

C band-32 ch.odd
L band- 32 ch.odd
C band- 40 ch
C band- 64 ch
C band- 72 ch
C band- 80 ch

Step8  Click Finish. The name Demand window appears (Figure 2-12).

Figure 2-12 TDMAggr Demand Window

Step9  Click Close.
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Step 10  To add a circuit, right-click the Ethernet Demand in the Project Explorer pane and choose New point to
point request. The New Request window appears (Figure 2-13).

Figure 2-13 New Request Window

Step 11  The New Request window contains four areas of information: Quantity, General, Src, and Dest.

Quantity Area
Quantity—Enter the number of circuits to be created.

General Area
» Label—Enter the label for the circuit. By default, VLAN_Circuit_x is used.
» Trunk Protection—Enter the trunk protection type. Allowed values are:
— Unprotected
- UPSR

- P/F—Select Forecast if this demand will be needed in the future. Select Present if this demand is
needed now. This parameter drives the list of pluggable port modules to be equipped on the card and
affects BoM reports.
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- Path Forcing—This option allows you to force the circuit routing on the traffic subnet associated
with this demand. Allowed values are:
- Auto—(Default) Causes the tool to automatically define the trunk path.
- Side x—Represents the label of the side on the Src site where the circuit is routed.
- Client Protection—Allowed values are:
— Unprotected
- 1+1 APS
» Circuit rate—Displays the allowed circuit rates.
Src Area
» Site—Select the source site. Allowed values include the list of sites added in the WDM traffic
channel.
» SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.
« Card—Select the Card. Allowed values are Auto and ADM-x. Auto allows the tool to select an
appropriate card type based on other constraints.
The Src area contains Working and Protected sub-areas.
Working sub area
» Port Num—Select the port number. The allowed values are Auto, and from 1 to 17. Selecting Auto
allows the tool to select an appropriate port number based on other constraints.
In addition to ports 1 to 16, port 17 also acts like a client port in TDM aggregated demands.
Following are the guidelines to use port 17:

— Port 17 must be selected only when the ADM-10G card is used in a single-card configuration.

— Port 17 supports the circuit rates VC4-64C/STS-192C. It also supports the circuit rates from
STS1/VC4 to STS-48c/VC4-16¢ or a combination of them.

— For circuit rates VC4-64C/STS-192C with the port number as Auto, port 17 automatically
becomes the source and the destination port. Port 17 will not be selected for any other circuit
rate unless the user specifically forces the port.

— Port 17 supports UPSR Client Protection on ANSI platform and SNCP client protection on ETSI
platform, except for the circuit rates VC4-64C/STS-192C.

- Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an
appropriate value.
Protected sub area
The following fields are available only if client protection is enabled:
» Port Num—Select the port number. The allowed values are Auto, and from 1 to 17. Selecting Auto
allows the tool to select an appropriate port number based on other constraints.
You can force port 17 as protected source or destination port for Client UPSR/SNCP protection with
circuit rates less than VC4-64/STS-192c.
- Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an
appropriate value.
Cisco Transport Planner DWDM Operations Guide, Release 9.3
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Step 12
Step 13

Step 14

Dest Area

Site—Select the destination site. Allowed values include the list of sites added in the WDM traffic
channel.

SFP lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select an
appropriate value.

Card—Select the card. Allowed values are Auto and ADM-x. Auto allows the tool to select an
appropriate card type based on other constraints.

The Dest area contains Working and Protected sub areas.

Working sub area

Port Num—Select the port number. The allowed values are Auto, and from 1 to 17. Selecting Auto
allows the tool to select an appropriate port number based on other constraints.

In addition to ports 1 to 16, port 17 also acts like a client port in TDM aggregated demands. The
guidelines to use the port are the same as given in the Working sub area for source ports.

Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

Protected sub-area

Port Num—Select the port number. Allowed values are Auto and 1 to 16. Auto allows the tool to
select an appropriate port number based on other constraints.

Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select
an appropriate value.

Click OK.

If you want to clone this demand, click the Clone button in the left corner of the screen. A new demand,
which is a copy of this demand, is created and appears in the Project Explorer pane.

Click the Check tab on the left corner of the window to generate a report showing the circuit path in the
WDM traffic channel and to check any over-allocation of bandwidth (Figure 2-14). The report shows, in
a row, each of the sites on the subnet, and each span in between.

Figure 2-14 Circuit Path View in a TDM Aggregated Demand
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Step 15

Step 16

CreatingaDemand

To add a regeneration site, click the Regeneration... icon in the toolbar of the DWDM channel tab. The
Regeneration Editor appears. The regeneration site can be created only at the trail level. For more
information, see the “2.7.10 Creating a Regeneration Site” section on page 2-41.

Click Close. To edit circuits, see the “4.11 Editing a TDM Aggregated Demand” section on page 4-53.

2.7.10 Creating a Regeneration Site

Note

Note

Step 1

A regeneration site is required when the optical communications link has to span long distances. The
optical signal has to be regenerated when the optical signal-to-noise ratio (OSNR) goes beyond a critical
limit. After a network is analyzed, the Optical Results highlights if any site requires regeneration. For
more information about optical results, see the “3.2.10 Viewing Optical Results” section on page 3-24.

Use the following procedure to create a regeneration site in the network.

A regeneration site cannot be a site with the functionality as OLA, OSC, pass-through, or hub.

The Regeneration... icon is active only when you select a trail in the Demand Editor.

In the Demand Editor, click the Regeneration... icon in the toolbar. The Regeneration Editor appears,
Figure 2-15. For more information about Cisco Transport Planner icons, see Appendix A, “GUI
Information and Shortcuts”.
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Step 2

Note

Step 3
Step 4

Note

Step 5

Figure 2-15 Regeneration Editor

In the Available Sites area, choose the site and click the down arrow icon. To remove a site added to the
Regeneration Sites list, choose the site and click the up arrow icon.

When adding more than one regeneration site to the path, ensure the regeneration sites are added in the
correct sequence to avoid unfeasible routing. For example, if you create a point-to-point demand from
sitel (source) to site 3 (destination), the sites available in the path are site 4 and site 5. Site 5 must be

selected first, followed by site 4, because site 5 is closer to site 1.

To sort the regeneration sites in the list, use the up and down arrow icons located on the left.

If you chose a source or destination card for a regeneration site, choose the card type for the site from
the drop-down list. The regeneration cards that are compatible with the source and destination cards are
displayed in the interface.

The OTU2_XP card has four modes. For more information on these modes, refer to the
“2.7.10.1 Configurations for OTU2_XP” section on page 2-43.

Colorless— Choose an option from the drop-down list. Colorless traffic demands are terminated at
colorless add/drop ports, so that, these demands can be tuned in all possible wavelengths without
changing the optical interface of the port.
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Step 6

Step 7

Note

CreatingaDemand

Note

These values apply only to the selected trail.

» Auto—(Default) Disables colorless functionality on the demand.

« Yes—Enables colorless functionality on the demand.

« No—Disables colorless functional